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1

Safety

1.1

Introduction

1.1.1

Contents
This document contains information that you need in order to use your product throughout the
applicable stages of the product life cycle. These can include the following:
■

Product identification

■

Delivery, transport, and storage

■

Mounting and installation

■

Commissioning and operation

■

Maintenance and repair

■

Troubleshooting

■

Dismounting

■

Disposal

Note!
This document does not substitute the instruction manual.
Note!
For full information on the product, refer to the instruction manual and further documentation on
the Internet at www.pepperl-fuchs.com.
The documentation consists of the following parts:
■

Present document

■

Instruction manual

■

Datasheet

Additionally, the following parts may belong to the documentation, if applicable:

1.1.2

■

EU-type examination certificate

■

EU declaration of conformity

■

Attestation of conformity

■

Certificates

■

Control drawings

■

Additional documents

Target Group, Personnel
Responsibility for planning, assembly, commissioning, operation, maintenance, and
dismounting lies with the plant operator.
Only appropriately trained and qualified personnel may carry out mounting, installation,
commissioning, operation, maintenance, and dismounting of the product. The personnel must
have read and understood the instruction manual and the further documentation.
Prior to using the product make yourself familiar with it. Read the document carefully.

2017-03

1.1.3

Symbols Used
This document contains symbols for the identification of warning messages and of informative
messages.
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Warning Messages
You will find warning messages, whenever dangers may arise from your actions. It is mandatory
that you observe these warning messages for your personal safety and in order to avoid
property damage.
Depending on the risk level, the warning messages are displayed in descending order as
follows:
Danger!
This symbol indicates an imminent danger.
Non-observance will result in personal injury or death.
Warning!
This symbol indicates a possible fault or danger.
Non-observance may cause personal injury or serious property damage.
Caution!
This symbol indicates a possible fault.
Non-observance could interrupt the device and any connected systems and plants, or result in
their complete failure.

Informative Symbols
Note!
This symbol brings important information to your attention.

Action

2017-03

This symbol indicates a paragraph with instructions. You are prompted to perform an action or
a sequence of actions.
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2

Product Specifications

2.1

Functional Overview
The WirelessHART gateway is the interface between the WirelessHART network and the
process control system. It supports WirelessHART networks with up to 250 network
participants and provides an RS-485 interface as well as an Ethernet interface. Both interfaces
transmit the HART or MODBUS protocol. OPC connectivity can be realized via the HART OPC
server. It can be configured via the device type manager (DTM) or device description (DD) in
connection with a configuration software. Furthermore, it provides a web interface for direct
access via a web browser.

Key Features

2.1.1

■

Graphical network analysis

■

Simple and automatic configuration options

■

Ethernet and RS-485 interface

■

HART and MODBUS protocol via both interfaces

■

Input WirelessHART wireless interface

■

24 V DC supply

■

Redundant power supply connections

Network Management
The WirelessHART gateway contains a network manager. The network manager takes care of
the wireless communication between the WirelessHART field devices. The network manager
takes care of the creation and maintenance of the wireless mesh network to ensure proper
communication between the WirelessHART field devices.

4

3
1

2

5
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Figure 2.1

Network management

1. Step 1: advertising
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2. Step 2: joining
3. Step 3: scheduling
4. WirelessHART gateway
5. WirelessHART field device
First, the network manager sends advertising messages to announce the network’s existence.
When a WirelessHART field device receives such an advertising message, it tries to join the
network. If the WirelessHART field device can identify itself with the same network ID and join
key as stored in the WirelessHART gateway, the field device is allowed to join the network.
Otherwise, the field device will be rejected.
The network manager can also instruct already joined devices to advertise on its behalf.
In the next step, the network manager sends scheduling information to the field device. The
field device is told how to participate in the network and receives various information from the
WirelessHART gateway:
■

Number and identity of neighboring WirelessHART field devices,

■

When to send messages and which channels to use,

■

When to repeat messages for other WirelessHART field devices,

■

The optimal communication path for messages as well as alternative communication
paths in case of failure.

During this process, the field device may also apply to send messages in certain intervals and
ask the network manager for the appropriate resources. The network manager then takes care
that these resources are available. For example, the network manager informs other
WirelessHART field devices when to repeat messages.

2.1.2

Security Management
The security manager is part of the WirelessHART gateway. To make communication safe, all
messages are encrypted with industry-standard AES-128 block ciphers with symmetric keys.
Therefore, messages are unreadable for external listeners.
The security manager distributes the encryption keys and changes them in certain (random)
intervals, as an option.

2.1.3

Virtual Remote I/O system
The WirelessHART gateway makes wireless communication accessible to host systems
capable of HART technology through the following principles.
WirelessHART devices and wired devices connected to a WirelessHART adapter are made
available to host systems via a virtual HART I/O system. This I/O system contains one or
multiple I/O cards. Each I/O card has up to 2 channels. To each channel, up to 6 wired field
devices may be connected in multi-drop mode.
see Figure 2.2 on page 11
The WirelessHART gateway assigns a virtual I/O card to each WirelessHART device and
stores card and channel values in a list. The I/O cards are assigned to the WirelessHART
devices in chronological order (0 ... 249). New WirelessHART devices in the network are
assigned to the next available I/O card.

2017-03

WirelessHART devices are always assigned to channel 0 of an I/O card. All wired devices
connected to a WirelessHART adapter are always assigned to channel 1 of the same I/O card
as the adapter (multi-drop mode).
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Figure 2.2

Network structure and corresponding I/O structure

1. Host application
2. WirelessHART gateway
3. WirelessHART field device (joined first): I/O card 0, channel 0
4. WirelessHART adapter (joined second): I/O card 1, channel 0
5. Wired devices 1...3 connected to WirelessHART adapter: I/O card 1, channel 1
If a WirelessHART device loses its connection to the WirelessHART gateway, it keeps its
position in the list and stays assigned to the respective I/O card. If the connection to the
WirelessHART gateway is re-established, the WirelessHART device has the same
channel/card values that it had before.
The same principle applies to the field devices connected to the WirelessHART adapter. After
communication to the WirelessHART gateway was lost, the field devices regain their previous
position as soon as the connection is re-established.
Note!
This list is stored in a non-volatile memory of the WirelessHART gateway. The card and
channel number assignment will remain the same after a restart of the WirelessHART gateway
or software.

2017-03

Long Tag Emulation
The WirelessHART communication protocol uses the long tag to address devices. However,
long tags are only supported by HART 6 devices and newer devices (HART 6 = version 6 of the
HART communication protocol; current version: HART 7). Older devices, for example HART 5
devices, have to be addressed by the "Message" field. If a HART 5 device is connected to the
WirelessHART network using a WirelessHART adapter, the WirelessHART gateway emulates
the long tag with the "Message" field.
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2.1.4

Gateway Cache Management
The WirelessHART gateway caches parameters and dynamic values of the wireless and wired
subdevices and makes them available to the host. Some commands are automatically cached
by the WirelessHART gateway (upon read). Other commands, for example dynamic values, are
only cached if the respective field device publishes them (upon publishing). See chapter 5.4.2
Burst Lists
The responses to the commands listed in the following table are cached in the WirelessHART
gateway. Commands in the same row have an identical response frame and share the same
cache memory. The write commands (17, 18, 22, 51) will never get an immediate answer, but
their response will be cached (caching upon write-confirmation).
Information Cached by WirelessHART Gateway
Cache

Command

Description

Static configuration
commands, cached upon
read or upon write
confirmation

0, 11, 21

Read unique identifier
(associated with tag or long
tag)

12, (17)

Read (Write) Message

13, (18)

Read (Write) Short Tag,
Descriptor, Date

20, (22)

Read (Write) Long Tag

50, (51)

Read (Write) Dynamic
Variable Assignments

1

Read Primary Variable

2

Read Current and Percentage

3

Read All Variables

9

Read Device Variables and
Status

33

Read Device Variables

93

Read Trend

48

Read Additional Device Status

Dynamic value commands,
cached upon publishing only

Status Information Caching
The WirelessHART gateway caches the device status byte separately for each wireless or
wired device. The device status will be cached from any type of received message, no matter if
from a wired or wireless device, or if it is a "published" or "normal" response.
The extended device status byte is cached in a similar way, but is available only for wireless
devices.

2.2

Scope of Delivery
The scope of delivery comprises the following components
Device WHA-GW-*

■

Antenna W-ANT-2400-2DB-ROD (Part. No. 215520)

■

3 stopping plugs for unused cable glands

■

Product documentation

2017-03

■
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2.3

Operating Elements and Indicators
Inside the enclosure of the WirelessHART gateway there are LED indicators, DIP switches and
buttons. The operating elements and indicators can be accessed when the enclosure is open.

Figure 2.3

WHA-GW with open enclosure

1. LEDs
2. Button A
3. Button B

2017-03

4. DIP switches
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2.3.1

LEDs

Figure 2.4

LED indicators

1. RS-485 communication status (yellow LED)
2. Power supply (green LED)
3. WirelessHART communication status (yellow LED)
4. Fault (red LED)
5. Ethernet communication status (yellow LED)
LED Indicators
LED indicators
RS-485 communication status (yellow LED)
LED flashes

A message is received by the WirelessHART gateway via the serial interface.
The LED does not flash if the message is not addressed to the WirelessHART
gateway or if a communication error was detected within the message.

LED off

No serial communication at present.

Power supply (green LED)
LED on

Power connected. The WirelessHART gateway ready.

LED flashes

Power connected, but the WirelessHART gateway is not yet ready to send
wireless commands, for example, right after power-up or after a device reset.

LED off

Power disconnected. The LED may remain off for up to 40 seconds after
connection to power (system boot-up).

WirelessHART communication status (yellow LED)
LED flashes

A WirelessHART message is received by the WirelessHART gateway via the
wireless interface (including published commands and excluding published
events and notifications).

LED off

No wireless communication at present.

Fault (red LED)
LED on

Hardware fault which makes normal operation of the WirelessHART gateway
impossible.

LED flashes

Under certain conditions the LED flashes while the WirelessHART gateway
application tries to eliminate the fault.

LED off

No hardware fault.

14

LED flashes

A message is received by the WirelessHART gateway via the Ethernet
interface. The LED does not flash if the message is not addressed to the
WirelessHART gateway or if a communication error was detected within the
message.

LED off

No Ethernet communication at present.

2017-03

Ethernet communication status (yellow LED)
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2.3.2

Buttons and DIP Switches

Figure 2.5

Buttons inside the enclosure of the WirelessHART gateway

1. Button A
2. Button B
Time pressed Function

Function of button A
> 3 seconds

Configuration reset: This button resets all parameters to the factory default
values, except the parameters set by button B and button A + B.
After 3 seconds, all LEDs light up to confirm the reset.


Function of button B
> 3 seconds

Communication reset: This button resets all parameters related to the wired
communication channels to the factory default values.
After 3 seconds, all LEDs light up to confirm the reset.


Function of button [A + B] (security mode disabled)
> 3 seconds

Password reset: When pressed while the Security Mode is disabled (
see
Figure 2.6 on page 16), the buttons reset the password of the web interface
(HTTPS password) to the factory default value. The factory default password
for the web interface (HTTPS) is "admin".
After 3 seconds, all LEDs light up to confirm the reset.


Function of button [A + B] (security mode enabled)
Network manager reset: When pressed while the Security Mode is enabled
(
see Figure 2.6 on page 16), the buttons reset the join key, network ID,
radio power and access mode to the factory default values.
After 3 seconds, all LEDs light up to confirm the reset.

2017-03

> 3 seconds
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Figure 2.6

DIP switches

1

Switches 1 - 4: Polling address

2

Switches 5 - 6: Baud rate

3

Switch 7: RS-485 termination

4

Switch 8: Security mode

Note!
When using the DIP switches 1 ... 4 for setting the polling address of the WirelessHART
gateway, you can set addresses ranging from 0 ... 15 only. Alternatively you can set the polling
address using the configuration software. See chapter 5.3.3 see chapter 5.3.4
If using the configuration software, you can set addresses ranging from 0 ... 63 (HART) or
0 ... 247 (MODBUS).
DIP switches 1 ... 4
SW2

SW3

SW4

Polling address

OFF

OFF

OFF

OFF

0

ON

OFF

OFF

OFF

1

OFF

ON

OFF

OFF

2

ON

ON

OFF

OFF

3

OFF

OFF

ON

OFF

4

ON

OFF

ON

OFF

5

OFF

ON

ON

OFF

6

ON

ON

ON

OFF

7

OFF

OFF

OFF

ON

8

ON

OFF

OFF

ON

9

OFF

ON

OFF

ON

10

ON

ON

OFF

ON

11

OFF

OFF

ON

ON

12

ON

OFF

ON

ON

13

OFF

ON

ON

ON

14

ON

ON

ON

ON

15
2017-03
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Note!
When using the DIP switches 5 ... 6 for setting the baud rate, this baud rate applies for the
HART protocol as well as the MODBUS protocol. Alternatively you can set the baud rate using
the configuration software. See chapter 5.3.3 see chapter 5.3.4
If using the configuration software you can set individual baud rates for the HART protocol and
the MODBUS protocol.
DIP switches 5 ... 6
SW5

SW6

Baud rate

OFF

OFF

9600

ON

OFF

19200

OFF

ON

38400

ON

ON

57600

Note!
The security mode has to be enabled (DIP switch 8) to change the join key using the DTM or
web interface or to reset the join key and network ID using the buttons inside the enclosure of
the WirelessHART gateway.
Caution!
Network security risk
Do not to use the security mode connection as a normal communication channel.
After the join key has been changed, disable the security mode (DIP switch 8 = OFF).
DIP switches 7 + 8
RS-485
termination

SW8

Security mode

ON

Connected

ON

Enabled

OFF

Disconnected

OFF

Disabled

2017-03

SW7
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3

Installation

3.1

Mounting Considerations

3.1.1

Positioning the WirelessHART Gateway
Install the WirelessHART gateway first, before installing other WirelessHART devices. This way
you can check for proper operation of new devices as they are installed. Nevertheless,
consider the location of future WirelessHART devices that will be routed through the
WirelessHART gateway to ensure good connectivity.
Guidelines for Planning a WirelessHART Network
■

A line-of-sight between communication partners always is desirable. If a line-of-sight is
not possible, the obstacles should not be massive and the partners should be more to the
edge of an obstacle to allow the wave to "bend" around it (diffraction effect).

■

Consider moving objects that could affect the device's antenna range.

■

Install wireless devices at least 1 m above the ground.

■

Make sure that the device's antenna is aligned vertically for best results.

■

Make sure that a minimum of 2 other WirelessHART devices are well within the antenna
range of the device.

■

Do not position WirelessHART devices directly below or above each other. They would be
outside each other's antenna range.

■

Install WirelessHART devices at least 1 m away from each other.

■

Antennas must be at least 6 cm away from any wall or any metallic material running
parallel to it.

■

Position the device as far away as possible from metal surfaces or walls containing metal.
There should be as little metal close to the device as possible.

■

Do not position other 2.4 GHz devices like cordless phone bases or WLAN routers near
WirelessHART devices. Keep in mind other wireless networks using the same frequency
spectrum (WLAN, Bluetooth, etc.). Wireless technologies used in an industrial
environment must be able to coexist without disrupting each other. If multiple networks
operate in one plant, a frequency management should be applied as part of
administration.

If it is not possible to mount the WirelessHART gateway outdoors, you can also connect a
remote antenna to the WirelessHART gateway and mount the remote antenna outdoors.

3.1.2

Antenna Characteristics
The included antenna W-ANT-2400-2DB-ROD (Part. No. 215520) is an omnidirectional dipole
antenna. If you point the antenna upwards, the signal radiates horizontally with an angle of
approx. 45 degrees above and below the horizontal (donut shaped). Almost no signal will be
radiated directly above and below the antenna. Consider this when planning a WirelessHART
network. The height differences between wireless devices in a network should not be too big.
This is valid only for an antenna, which is placed outdoors with no metal surfaces in immediate
vicinity. The radiation pattern changes significantly when metal surfaces are close to the
antenna.

2017-03

The following diagrams show the antenna gain in two different planes.
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Figure 3.2
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3.1.3

Examples for Good and Poor Positioning

Figure 3.3

Wave propagation, schematic representation (alpha = approx. 45°, may vary
considerably)

1

Weaker signal above and below; almost no signal directly above and below

2

Stronger signal sideways

y

x

Good positioning: Devices are within each other's antenna range

2017-03

Figure 3.4
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y

x

Figure 3.5

3.2

Poor positioning: Devices are not within each other's antenna range

Installing the Antenna
Danger!
Explosion hazard from connection or disconnection activities
Connection and disconnection of cables or antennas may cause a spark that can ignite a
potentially explosive atmosphere.
Connect or disconnect cables or antennas only in the absence of a potentially explosive
atmosphere.
Note!
Avoid radio wave deflections
In order to ensure full functionality of the device antenna, the antenna must have a minimum
distance of 20 cm from any surrounding personnel or items when the device is in operation.

Connecting the Standard Antenna (W-ANT-2400-2-ROD)

2017-03

Firmly screw the antenna to the antenna terminal of the WirelessHART gateway.
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3.3

Installing a Remote Antenna
If the WirelessHART gateway is mounted indoors, or if there are many metal obstacles in the
immediate surroundings, you can also connect a remote antenna to the WirelessHART
gateway. Note that the use of a different antenna or the use of an antenna with a different
antenna gain is subject to legal restrictions.
Installation Diagram

1

2

3

4

5

6

7

Figure 3.6

Installation diagram

1. External antenna (omnidirectional or directional antenna)
2. Coaxial adapter
3. Coaxial cable
4. /4 surge protector
5. Coaxial cable
6. Coaxial adapter
7. WirelessHART gateway
Connection Diagram
Standard
Antenna
2 dBi

Adapter

Coaxial Cable

Surge
Protector
or
Adapter

Coaxial Cable

WirelessHART
Gateway

Adapter

WHA-GW-*
TNCM

TNCF

NF NM

NM NF

NF

NM

NM

NF

TNCM

TNCF

NM NF

NF

NM

NM

NF

TNCM

TNCF

Non-Standard
Antenna 6 ... 14 dBi
WHA-GW-*
NF

NM

Maximum Gain

Connection diagram for standard and non-standard antennas
2017-03

Figure 3.7

22

WHA-GW-F2D2-0-A*-Z2-ETH
Installation

Installation Examples

Antenna

Cable configurations for coaxial cable WACC-CA-NM-NM-*
WirelessHART
1
US & Canada
gateway radio power EU

W-ANT-2400-2-ROD 10 dBm
Omnidirectional rod
antenna
2 dBi
W-ANT-2400-6dBROD-NF
Omnidirectional rod
antenna
6 dBi

10 dBm

■

1m

■

1m

■

1m+1m

■

1m+1m

■

2m

■

2m

■

2m+2m

■

5m

■

5m+1m

■

5m+2m

■

5m+2m

■

5m+5m

■

10 m

W-ANT-2400-8dBPAN-NF
Directional panel
antenna
8.5 dBi

10 dBm

W-ANT-2400-14dBPAN-NF
Directional panel
antenna
14 dBi

10 dBm

■

5 m + 10 m

0 dBm

■

1m

■

1m+1m

■

2m

■

2m+1m

■

2m+2m

The use of alternative
antennas is not
allowed.

The use of alternative
antennas is not
allowed.
The use of alternative
antennas is not
allowed.

1
The power level of the WirelessHART gateway can be configured using the Wireless
Communication Parameters. See chapter 5.2

Danger!
Explosion hazard or loss of radio approval through unsuitable accessories
The use of unsuitable or unapproved accessories may void the Ex certification or radio
approval of the device and present an explosion hazard or violate the national radio
regulations.
Only use suitable, certified remote antennas and accessories that are listed in the installation
examples or that respect the limits mentioned below. If in doubt, consult your national
regulations expert.
Remote antennas and accessories must respect the following limits:
■

Antenna must comply with the laws for usage of 2400 MHz equipment of the country of
installation.

■

Radio frequency  50 µJ

■

Radio frequency power  2 W

■

2017-03

■

Antenna gain  20 dBi
Furthermore, the allowed antenna gain depends on the laws for usage of 2400 MHz
equipment of the country of installation.
Maximum gain for EU  4 dBi
Maximum gain for US & Canada  2 dBi
The maximum gain consists of the antenna gain minus the loss of all other components,
such as, cables, adapters, etc.
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Danger!
Danger to life from electric shock through transients and lightning in outdoor installations
Outdoor installations can be subject to lightning.
■

Install a surge protector to protect the installation against transients or damage caused by
lightning.

■

Refrain from installation and maintenance activities during thunderstorms.

Danger!
Explosion hazard from connection or disconnection activities
Connection and disconnection of cables or antennas may cause a spark that can ignite a
potentially explosive atmosphere.
Connect or disconnect cables or antennas only in the absence of a potentially explosive
atmosphere.
Caution!
Property damage through wrong installation
Wrong installation may impair the function of the WirelessHART network or cause damage to
the WirelessHART gateway.
Ensure that only trained and qualified personnel carry out mounting and installation of the
remote antenna and the related accessories such as cables, surge protectors, and adapters.

Connecting a Remote Antenna
1. Select an installation example that meets the legal requirements and restrictions of the country of installation. See table "Installation Examples" on page 23
2. Install the components according to the installation diagram.

see Figure 3.6 on page 22

3. Install the surge protector according to the instructions given by the manufacturer. If
possible, the surge protector should be grounded directly to keep the ground connection as
short as possible. Note that only a complete protection system according to IEC 62305-1
can protect your equipment and personnel.
4. Protect outdoor connections with weatherproof sealing tape to minimize corrosion and to
improve long-term durability.

3.4

Mounting the Gateway
Danger!
Explosion hazard from live wiring of non-intrinsically safe circuits
If you connect or disconnect energized non-intrinsically safe circuits in a potentially explosive
atmosphere, sparks can ignite the surrounding atmosphere.
Only connect or disconnect energized non-intrinsically safe circuits in the absence of a
potentially explosive atmosphere.
Danger!
Explosion hazard from sparking when using operating elements

Only use operating elements (e.g., switch, slider, button, etc.) in the absence of a potentially
explosive atmosphere.

24
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Using operating elements in a potentially explosive atmosphere can cause sparks that can
ignite the surrounding atmosphere.
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Danger!
Danger to life from electric shock through degree of protection violation
Failing to ensure the degree of protection for the enclosure according to EN 60529 can result in
severe or lethal electric shock.
Ensure that the enclosure meets the required degree of protection during mounting and
installation activities: 
- All seals must be undamaged and correctly fitted
- All screws of the housing/housing cover must be tightened with the appropriate torque
- Only cables of the appropriate size must be used in the cable glands
- All cable glands must be tightened with the appropriate torque
- All unused cable glands must be sealed or plugged with corresponding stopping plugs
Danger!
Explosion hazard from overvoltage
Using accessories or devices that are not suitable for the specified overvoltage category can
lead to added voltages. This can result in a voltage flashover generating sparks. The sparks
can ignite the surrounding potentially explosive atmosphere.
Ensure that all circuits connected to the device comply with the overvoltage category II (or
better) according to IEC/EN 60664-1.
Danger!
Danger to life from using damaged or repaired devices.
Using a defective or repaired device can compromise its function and its electrical safety.
■

Do not use a damaged or polluted device.

■

The device must not be repaired, changed or manipulated.

■

If there is a defect, always replace the device with an original device from Pepperl+Fuchs.

The mounting location should be well accessible for mounting and electrical installation. Make
sure that there is enough space to open the enclosure cover and to access the terminals,
switches, and cable glands. Choose a mounting location that meets the requirements of the
climatic limits specified in the technical data.
The enclosure has a degree of protection of IP65 and is designed for wall mounting (mounting
accessories and tools not included). See table "Installation torque for cable glands and
enclosure cover" on page 31
Required tools:
■

2 screws (M6)

■

Drill

■

Screwdriver

2017-03

Depending on the mounting surface, you may need additional mounting material.
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2

1

1

2

Figure 3.8

Mounting holes and enclosure screws

1

Mounting holes for M6 screws

2

Enclosure screws

Mounting the Gateway
1. Drill 2 holes into the mounting surface so that they match the holes of the enclosure.
2. Screw the device to the mounting surface using M6 screws.

3.5

Preparing Ethernet Connection
The WirelessHART gateway is equipped with a galvanically isolated Ethernet interface. Note
that the maximum length of the cable running from the WirelessHART gateway to the Ethernet
access point is 100 m or less, depending on the cable type and transfer rate. Ensure sufficient
relief of tension on the cables during installation and note the minimum bending radii of the
cables.
Danger!
Explosion hazard from connection or disconnection activities
Connection and disconnection of cables or antennas may cause a spark that can ignite a
potentially explosive atmosphere.
Connect or disconnect cables or antennas only in the absence of a potentially explosive
atmosphere.

Wiring the Ethernet Interface
1. Unscrew the 4 screws of the enclosure cover and remove the cover.
2. Route the Ethernet cable through the cable gland in the middle of the enclosure of the
WirelessHART gateway. The permissible cable diameter lies between 6 ... 10 mm.

2017-03

3. Connect the Ethernet cable to the Ethernet terminal block. Depending on the Ethernet
access point, use straight-through or crossover wiring.
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The WirelessHART gateway is now connected to the Ethernet network. The yellow
Ethernet communication status LED starts flashing when a correct HART or MODBUS
protocol message is received.
4. Tighten the cable glands with appropriate torque. See table "Installation torque for cable
glands and enclosure cover" on page 31
5. Seal empty cable glands with the provided plugs.
6. Tighten the enclosure cover with appropriate torque. See table "Installation torque for cable
glands and enclosure cover" on page 31
You do not need a RJ45 plug to connect the Ethernet cable to the WirelessHART gateway.
However, you need a RJ45 plug at the other end of the cable to connect the cable to an
Ethernet hub, switch, router, or PC.

Pinout of the RJ45 Plug
There are different standards for the RJ45 plug: T568A and T568B. The difference between
both standards is that some wires are connected to different pins of the plug.

87

65

43

21

Signal

Pins

Wire color of T568A plug

Wire color of T568Bplug

TX+

1

White/green stripe

White/orange stripe

TX-

2

Green

Orange

RX+

3

White/orange stripe

White/green stripe

4

Blue

Blue

5

White/blue stripe

White/blue stripe

6

Orange

Green

7

White/brown stripe

White/brown stripe

8

Brown

Brown

2017-03

RX-
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Straight-Through or Crossover Wiring
Depending on the network topology, use straight-through or crossover wiring to connect the
WirelessHART gateway to an Ethernet access point. Note that newer Ethernet hubs, switches,
and routers are able to detect whether straight-through wiring or crossover wiring has been
used and adjust the pinout automatically if necessary.
Wiring with a T568A Plug
Terminal block an
WirelessHART gateway

Straight-through

Crossover

T1

Brown

Brown

White/brown stripe

White/brown stripe

Blue

Blue

White/blue stripe

White/blue stripe

RX-

Orange

Green

RX+

White/orange stripe

White/green stripe

TX-

Green

Orange

TX+

White/green stripe

White/orange stripe

SHD

Cable shield

Cable shield

Terminal block an
WirelessHART gateway

Straight-through

Crossover

T1

Brown

Brown

White/brown stripe

White/brown stripe

Blue

Blue

White/blue stripe

White/blue stripe

RX-

Green

Orange

RX+

White/green stripe

White/orange stripe

TX-

Orange

Green

TX+

White/orange stripe

White/green stripe

SHD

Cable shield

Cable shield

T2

Witing with a T568B Plug

T2

3.6

Preparing RS-485 Connection

2017-03

The WirelessHART gateway is equipped with a fully galvanic isolated RS-485 interface. Note
that the maximum length of the cable running from the WirelessHART gateway to the process
control system is 1200 m or less, depending on the cable type and transfer rate. Use shielded
twisted pair (STP) cables only. Ensure sufficient relief of tension on the cables during
installation and note the minimum bending radii of the cables.
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Note!
Terminator
The interface is daisy-chain capable through its duplicated RS-485 terminal block. If the RS485 cable ends at the WirelessHART gateway and is not routed to other devices (no daisychain connection), activate the integrated terminator to ensure reliable RS-485 communication.
The terminator can be switched on or off using the operating elements and indicators inside the
enclosure (see chapter 2.3) or using the serial interface (see chapter 5.3.1).

Figure 3.9

RS-485 interfaces

1. First RS-485 interface
2. Second RS-485 interface
Note!
Grounding
If the cable shield is grounded, the grounding should only be connected to one end of the
cable, in order to avoid equipotential bonding currents.

Wiring the RS-485 Interfaces
1. Unscrew the 4 screws of the enclosure cover and remove the enclosure cover.
2. Route a shielded twisted pair cable through the first cable gland from the left on the bottom
of the enclosure. The permissible cable diameter lies between 6 ... 10 mm.
3. Connect the shielded twisted pair cable to the first RS-485 terminal block.
4. For a daisy-chain connection, route the second shielded twisted pair cable through the
second cable gland from the left on the bottom of the enclosure. Connect the second
shielded twisted pair cable to the second RS-485 terminal block.
5. If the RS-485 bus ends at the WirelessHART gateway, set DIP switch number 7 to "ON" to
activate the terminator. See chapter 2.3.2
The WirelessHART gateway is now connected to the RS-485 network. The yellow RS485 communication status LED starts flashing when a message is received.
6. Tighten the cable glands with appropriate torque. See table "Installation torque for cable
glands and enclosure cover" on page 31
7. Seal empty cable glands with the provided plugs.
8. Tighten the enclosure cover with appropriate torque. See table "Installation torque for cable
glands and enclosure cover" on page 31
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Gateway Wiring (RS-485 Connection)
Wire RS-485 cable

Terminal WHA-GW

Meaning

RxD/TxD - (RS-485 A)

A

RS-485 differential signal

RxD/TxD + (RS-485 B)

B

Shield

SHD

Cable shielding
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3.7

Connecting to Power Supply and Grounding
Danger!
Explosion hazard from premature powering
Powering parts of the system during installation or maintenance leads to added currents. This
very likely results in a current flashover generating sparks. The sparks can ignite the
surrounding potentially explosive atmosphere.
Prior to installation and maintenance activities, ensure that the device is disconnected from the
power supply. Activate the power supply only after all the circuits required for operation have
been fully assembled and connected
There are two 24 V DC power supply terminal blocks located inside the WirelessHART
gateway, allowing for redundant power supply. Open the enclosure cover to access the terminal
blocks.
Note!
Ensure sufficient relief of tension on the cables during installation and note the minimum
bending radii of the cables.

Figure 3.10

Power supply

1. First power supply connection
2. Second (redundant) power supply connection
3. Ground connection

Connecting to Power Supply and Grounding
1. Connect one of the grounding terminals to a ground wire.
2. Unscrew the 4 screws of the enclosure cover.

see Figure 3.10 on page 30

see Figure 3.8 on page 26

3. Remove the enclosure cover.
4. Ensure that appropriate power is supplied.
5. Draw the power cable through the second cable gland from right. 
The permissible cable diameter lies between 6 ... 10 mm.
6. Connect the power cable to the first power supply connection "Line 1" observing polarity.
see Figure 3.10 on page 30
7. If you want to connect a redundant power supply (optional), draw the second power cable
through the cable gland on the far right of the enclosure.
8. Connect the second power cable to the second power supply connection "Line 2"
observing polarity.
9. Tighten the cable glands with appropriate torque. See table "Installation torque for cable
glands and enclosure cover" on page 31
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The WirelessHART gateway is connected to power supply.
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10.Seal empty cable glands with the provided plugs.
11.Tighten the enclosure cover with appropriate torque. See table "Installation torque for cable
glands and enclosure cover" on page 31
Note!
The tightening torques of cable glands depend on what type of cable is used and must
therefore be determined by the user. The cap nuts must be securely tightened. Tightening the
cap nuts too tight can have a negative effect on the protection class. The following figures
should be taken as rough guides only.
Installation torque for cable glands and enclosure cover
Installation torque cable
glands

Type of cable glands

2.5 Nm

Plastic

4.11 Nm

Nickel plated brass

4.11 Nm

Stainless steel

Installation torque enclosure cover
2.5 Nm
Installation torque for cable glands and enclosure cover

2017-03

Table 3.1
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Commissioning

4.1

Connecting via Ethernet
Once the WirelessHART gateway is connected to the Ethernet jack of your PC, update the local
network settings of your PC to communicate with the WirelessHART gateway.

Update Network Settings (Windows 7)
1. Connect the Ethernet cable to the Ethernet jack of your PC.
2. Choose Windows Icon > Control Panel > Network an Sharing Center.
3. In the View your active networks section, click Local Area Connection and then click
Properties.
The Local Area Connection Properties window opens.

Figure 4.1

Local Area Connection Properties window

4. Select the list entry Internet Protocol (TCP/IP).
5. Press Properties.

2017-03

The Internet Protocol (TCP/IP) Properties window opens.
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Figure 4.2

Entering IP address and subnet mask

6. Choose Use the following IP address and type 192.168.1.100 into the field IP
address.
7. Type 255.255.255.0 into the field Subnet mask.
8. Press OK.
Your PC is now ready to communicate with the WirelessHART gateway.

4.2

Connecting via RS-485
Once the WirelessHART gateway has been connected to the RS-485 bus, you can connect the
RS-485 bus to your PC. This can be done by using an RS-485 to RS-232 converter or using an
RS-485 to USB converter.
Note!

2017-03

The usage of an approved RS-485 converter is recommended for faster configuration and
more reliable high-speed operation. In addition, the usage of a galvanically isolated RS-485
converter is strongly recommended for permanent installations.
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Connect the RS-485 Bus to your PC
1. Connect the RS-485 to RS-232 converter or the RS-485 to USB converter to your PC.
2. To find out to which COM port the converter is connected, open the Windows® device
manager. Click Windows Icon > Control Panel > System > Device Manager.
3. Under Ports (COM & LPT) you see the converter and its COM port. Make a note of the
COM port number. You will need the COM port number when setting up the communication
DTM for the RS-485 connection.

USB converter in device manager

2017-03

Figure 4.3
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5

Configuration via Web Interface
When configuring the WirelessHART gateway via the web interface, the WirelessHART
gateway must be connected to your PC via Ethernet.

Log in to the Web Interface
1. Start your web browser.
2. If your web browser uses a proxy, deactivate the proxy.
3. Type the IP address of the WirelessHART gateway into the address field. The default IP
address is 192.168.001.001. If you changed the IP address of the WirelessHART
gateway, type in the new IP address.
Depending on the security settings of your web browser, you may see a security warning.
In this case, click OK and proceed to the login screen.

Figure 5.1

Entering login data for secure connection

4. Either log in as user/operator or as administrator. Enter your user name and password. The
default user is admin and the default password is admin.

2017-03

5. Click OK.
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5.1

Identification Parameters
The identification parameters provide various information about the device and identify the
device within the network.

Figure 5.2

Parameter > Identification

Identification Parameters
Parameter

Description

Device Long
Tag

Identifies the device in a WirelessHART network. Enter up to –
32 characters.

Device Tag

Identifies the field device within the process plant. Enter up to –
8 characters.

Descriptor

Further description of the device. Enter up to 16 characters.

–

Date

User-defined date (e.g. last parameter change). Format:
DD.MM.YYYY
The Date parameter is not modified by the WirelessHART
gateway. It must be set by the user or a host application.

–

Message

User-defined message. Enter up to 32 characters.

–

Country
Code

Select the country code of the country in which the device is –
operated from this drop-down list.
Identification Parameters

2017-03

Table 5.1

Default
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5.2

Wireless Communication Parameters

5.2.1

Setup
The setup parameters contain the necessary information for establishing and maintaining a
WirelessHART network.

Figure 5.3

Parameter > Wireless Communication > Setup

Changing the Join Key throughout the Network
Note!
Prerequisites
In order to change the join key network password parameter, activate the security mode with a
DIP switch inside the enclosure of the WirelessHART gateway. Set the DIP switch 8 to ON.
see Figure 2.6 on page 16
In the security mode, the CMD 768 HART command can be used to set the join key of the
WirelessHART gateway as required.

2017-03

1. In the web interface, go to Wireless Communication > Setup.
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Figure 5.4

Wireless Communication > Setup

2. In order to change join key on all devices throughout the network: Use the Join Key Part
1 ... 4 of 4 (HEX) fields.
Use the double arrow buttons to Write the Join Information.
A status message will inform you whether the procedure was successful. If a problem
occurred a NE 107 maintenance symbol will be displayed in the lower status bar. Clicking
on the symbol will provide you with information on the problem. For more information on the
NE 107 symbols, see chapter 5.2.2
Tip
Re-Joining Devices with Issues
For an overview of all devices in the network go to Wireless Communication > Operating
Modes. NE 107 status information symbols inform on the status of each device in the network.
In order to access a device that is temporarily out of operation or needs maintenance, use the
join key that was previously used when this device was active in the network. The old join key
allows the device to re-join the network without having to change it.
Caution!
Network security risk

2017-03

For security reasons do not use the security mode connection as a normal communication
channel. After having changed the join key, disable the security mode using the DIP switch
(DIP switch 8 = OFF).
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Caution!
Possible loss of connection when changing Network ID
If you change the Network ID parameter of an already operating WirelessHART network, the
WirelessHART gateway stores the new network ID and applies the network ID the next time the
network is reformed (note that reforming the network can take a long time). When the new
network ID becomes active, the connection to other WirelessHART devices can get lost.
When changing the network ID in the WirelessHART gateway, write the new network ID to each
wireless device in the network using either the wired or the wireless connection. Again, the new
network ID is stored in the device and is applied the next time the network is reformed.
Setup Parameters
Parameter

Description

Network Tag

Identifies the device in a WirelessHART network. Enter up to –
32 characters.

Network ID

Each wireless device needs to store a network ID to identify 1945
the WirelessHART gateway it is expected to connect to. Enter
up to 5 digits. The network ID may range from 0 ... 65535.
Press Write Join Information to store the new network ID to
the WirelessHART gateway. Remember to change the
network ID of the other wireless devices in the network, too.
The network has to be reformed before the new network ID
takes effect. To reform the network, choose Reform Network
in the Additional Functions > Reset menu.

2017-03

Join Key Part The join key is a common network password. Each wireless
1 ... 4
device needs this join key to be allowed to join the network.
The join key consists of up to 32 hexadecimal characters
(0 ... 9, a ... f). There are 4 text fields. Enter up to 8
hexadecimal characters into each text field. Each text field
must contain the same number of characters (e.g., 5 each).
Press Write Join Information to store the new join key to the
WirelessHART gateway.
This parameter can only be edited if the security mode is
activated by means of a DIP switch.
see Figure 2.6 on
page 16
In order to change the join key, in the gateway web interface
go to Wireless Communication > Setup and change the
join key in the Join Key Part 1 ... 4 of 4 (HEX) fields.
A status message will inform you whether the procedure was
successful.
If the join key is changed, the currently joined wireless
devices will remain connected with the network. However, no
device will be allowed to join unless it stores the new join key.
Available only online.

Default

E090D6E2
DADECE94
C7E9C8D1
E781D5ED

Write Join
Information

Stores the Network ID and Join Key to the WirelessHART
gateway. Please read the information related to the network ID
and join key in this section including the security notes.
Available only online.

RTC Date

Real-time clock (RTC) date setting for the network. Enter a
date in the following format: DD:MM:YYYY.
Available only online.

–

RTC Time

Real-time clock (RTC) time setting for the network. Enter a
time in the following format: hh:mm:ss.
Available only online.

–

Network start Shows the date at which the network was (re)started.
date
Available only online.

–

Network start Shows the time at which the network was (re)started.
time
Available only online.

–
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Parameter

Description

Allow new
Devices

Specify if new devices are allowed to join the WirelessHART all
network.

Radio Power Power level of the radio transmitter of the WirelessHART
gateway, which should normally be set to 10 dBm. Observe
local restrictions for 2400 MHz equipment.

Default

10 dBm

Bandwidth
Profile

This option allows you to increase network performance by
Normal
reducing the latency, which increases the energy
Bandwidth
consumption and reduces battery life of the network
Profile
components. We recommend that you use the medium and
high performance profiles if latency reduction is more
important than battery life.
The network has to be reformed for the new bandwidth profile
to become active. To reform the network, choose Reform
Network in the Additional Functions > Reset menu.

Global
Advertising
Timeout

If Global Advertising is activated, the WirelessHART
–
gateway and the network components will send a series of
identification messages at a frequency higher than normal to
identify new wireless devices and to reduce the network join
time. The messages are sent until the Global Advertising
Timeout is reached.
Enter the timeout in minutes. The timeout may range from
1 ... 255 minutes.

Activate
Global
Advertising

If activated, the network manager sends advertising
messages to announce the network’s existence. When a
WirelessHART field device receives such an advertising
message, it tries to join the network.
Enabling Global Advertising increases energy consumption
of the network components. Therefore we recommend that
you use this features only if needed, for example if you expect
new devices to join the network. Note that you can activate
Global Advertising without reforming the network.

Table 5.2

Setup Parameters

You can use the Channel Blacklist to disable selected channels. If there are other wireless
networks in the area where the WirelessHART network is located, you can make sure that
channels are not used by multiple networks at a time.

Channel Blacklist

2017-03

Figure 5.5
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Create Channel Blacklist
1. To disable a channel, deactivate its check box in the Channel Blacklist area. Note that at
least 5 channels must remain active.
2. Click Send to Device to transfer the updated blacklist settings to the WirelessHART
gateway. Note that the WirelessHART gateway stores the updated blacklist but does not
apply the updated settings unless the network is reformed.
3. Go to Additional Functions > Reset and click Reform Network to apply the updated
channel blacklist.
Example!
Note that a WLAN channel based on the IEEE 802.11 standard is wider than a WirelessHART
channel based on the IEEE 802.15.4 standard. If running a WirelessHART network in such an
area, we recommend that you also disable adjacent channels. For example, if channel 5 is
already occupied by a wireless network based on the IEEE 802.11 standard, we recommend
that you disable the WirelessHART channels 4, 5, and 6.
Note!
In addition to the manual channel selection, the WirelessHART network adapts the channel
usage dynamically to new situations, for example if a new wireless network is installed in the
area where the WirelessHART network is located.

5.2.2

Operating Modes
The Operating Modes table displays all devices of the WirelessHART network and their
operation modes. It represents the virtual I/O system of the WirelessHART gateway. See
chapter 2.1.3
Whenever a wireless device joins the network, it is automatically inserted into the Operating
Modes list if it is not already existing. Wired devices connected to a WirelessHART adapter will
also be inserted.

Figure 5.6

Parameter > Wireless Communication > Operating Modes

2017-03

If required, click Refresh to reload the operation mode parameters of all devices.
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Caution!
System failure
If you click Refresh right after the device was switched on or reset, the system may stop
responding.
If the device was switched on or reset, wait about 1 minute until the boot process is complete
before you click Refresh.
Note!
If using the DTM and PACTware to configure the WirelessHART gateway, the following data is
available only during online parameterization.
General Data
Displayed
Information

Description

Long Tag

Displays the long tag of the device.
HART 5 devices and older devices do not support long tags. For those
devices, the WirelessHART adapter uses the content of the Message field
which will be displayed here instead.

I/O Card

Indicates the virtual I/O card number to which the device is mapped to. See
chapter 2.1.3

Channel

Indicates the channel of the virtual I/O card that the device is mapped to. See
chapter 2.1.3
The value 0 identifies a WirelessHART device or a WirelessHART adapter,
while the value 1 identifies a wired device connected to a WirelessHART
adapter.

Device Type

Displays the device type as registered at the HCF.

Status

The following communication statuses exist:
communication not possible
communication possible, device not identified
(flashing) communication possible, identification ongoing
device connected and identified

Dev. Status

Note that the device status displayed in the list may differ from the actual
device status because the HART status bits may be interpreted differently.
The following device statuses exist:
maintenance required
out of specification
check function

2017-03

failure
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Operating Mode Parameters
Parameter

Description

Routing
Device

Indicates whether the device is allowed to act a routing device. This option
enables you to set up a star network, or to increase the battery life of certain
devices.
To deactivate the routing functionality, deactivate the corresponding check
box in the Routing Device column.
The network has to be reformed before the activated/deactivated routing
functionality takes effect. To reform the network, choose Reform Network in
the Additional Functions > Reset menu.

Fast Pipe

This option establishes a direct connection to a selected device. The fast pipe
connection is about 4 times faster than a regular connection, which enables
you to perform fast updates.
To establish a direct connection to a selected device, activate the Fast Pipe
check box. Note that you can activate the Fast Pipe option only for one device
at a time.

Flush Cache

This option deletes the cache of the received HART commands.
Note that the measured values will not be deleted to allow host applications to
work with the last measured values.

Force
This option forces a device to resend its identification, for example if a
Identification communication failure occurred.
Note that this option is available only for devices that have not been identified
yet.
Delete Device To remove a device from the list, click the
X-sign at the end of the row.
Note that this option is available only for devices that have no connection to
the network.
Table 5.3

5.3

Operating Mode Parameters

Wired Communication Parameters
Note!
If you are connected to the WirelessHART gateway via Ethernet using the HART IP
communication DTM, make sure to update the parameters of the HART IP communication
DTM when changing the following parameters of the WirelessHART gateway.
■ Parameterization > Wired Communication > Interfaces > Ethernet > IP Address
Parameterization > Wired Communication > Protocols > HART > Bus Address

■

Parameterization > Wired Communication > Protocols > HART > Port Number

2017-03

■
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5.3.1

Serial Interface
The WirelessHART gateway can connect to the host system via an Ethernet interface or a
serial interface. This section describes the parameters for the serial interface.

Figure 5.7

Parameter > Wired Communication > Interfaces > Serial

Serial Interface Parameters
Parameter

Description

Default

Termination
Resistor
Selection

Select if you prefer to activate the termination resistor of the
WirelessHART gateway via the DIP switches inside the
enclosure (see chapter 2.3) or via software.

DIP switches

Termination
Resistor

Connect or disconnect the termination resistor of the
Disconnected
WirelessHART gateway. This drop-down list depends on the
value of Termination Resistor Selection. If the value of
Termination Resistor Selection is "DIP switches", this
checkbox is read only.

Protocol
Selection

Select whether you want to use HART or MODBUS RTU for
serial communication.

Table 5.4

5.3.2

HART

Serial Interface Parameters

Ethernet Interface

Figure 5.8
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Parameter > Wired Communication > Interfaces > Ethernet
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The WirelessHART gateway can connect to the host system via an Ethernet interface or a
serial interface. This section describes the parameters for the Ethernet interface.
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Caution!
Possible loss of Ethernet connection
After enabling DHCP using the IP address assignment (DHCP) parameter, the host can lose
the Ethernet connection due to the new, automatically assigned IP address.
Ethernet Interface Parameters
Parameter

Description

Default

IP
configuration
mode (DHCP,
DNS)

Select Manually to configure the IP address, gateway
Manually
address, and Domain Name Server (DNS) manually, or select
Automatic to enable automatic configuration via the
Dynamic Host Configuration Protocol (DHCP) server. If you
choose Automatic, all other input fields in the window will be
grayed out (read only).

IP Address

If using manual configuration, enter the IP address of the
WirelessHART gateway.

192.168.1.1

Netmask

If using manual configuration, enter the subnet mask.

255.255.255.0

Gateway
address

If using manual configuration and if necessary, specify the IP 0.0.0.0
address of the WirelessHART gateway in the IP network.
Note that this is not the IP address of the WirelessHART
gateway. If changing the gateway address, it can take up to
10 seconds for the changes to take effect.

DNS 1

If using manual configuration, enter the address of the first
Domain Name Server (DNS 1).

0.0.0.0

DNS 2

If using manual configuration, enter the address of the
second Domain Name Server (DNS 2).

0.0.0.0

MAC Address Displays the MAC address of the WirelessHART gateway.
Note that the MAC address is a characteristic of the device
itself and cannot be changed. Each device has a unique MAC
address.
Write
Ethernet
Information
Table 5.5

5.3.3

Applies the current Ethernet settings from above to the
WirelessHART gateway.

Ethernet Interface Parameters

HART Protocol

2017-03

The protocol parameters configure the protocols that run over the serial interface or the
Ethernet interface (HART or MODBUS).
When using the serial interface, only one protocol can be active at a time (either HART or
MODBUS), depending on the value of the serial interface parameter Protocol Selection. See
chapter 5.3.1
When using the Ethernet interface, there is no need to select a protocol. Both protocols run
parallel using different port numbers.
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Figure 5.9

Parameter > Wired Communication > Protocols > HART

HART Parameters
Parameter

Description

Default

Serial
Bus Address
Selection
Bus Address

Select DIP switches to specify the polling address of the
DIP switches
WirelessHART gateway using the DIP switches inside the
enclosure (see chapter 2.3) or select Software to specify the
polling address in the following field.
■

■

■

If Bus Address Selection is set to DIP switches, this is 0
a read-only field.
If using the DTM and PACTware® for specifying the polling
address, this field is a read-only field and you must enter
the polling address in the HART IP Communication
DTM. See chapter 6.1
If using the web interface for specifying the polling
address, enter the polling address for the WirelessHART
gateway.

Baud Rate
Selection

Select DIP switches to specify the baud rate of the
DIP switches
WirelessHART gateway using the DIP switches inside the
enclosure (see chapter 2.3) or select Software to specify the
baud rate in the following field.

Baud Rate

If using the DTM or web interface for specifying the baud rate, 19200
select the baud rate for the WirelessHART gateway from the
drop-down list. If Baud Rate Selection is set to DIP
switches, this parameter is read only.

Ethernet
Port Number

Enter the port number of the WirelessHART gateway (HART
over UDP, Ethernet Interface).

5094

If you change the Ethernet port for the HART protocol, the default port remains open and
active. Thus, you can communicate with the WirelessHART gateway over the default port
(5094) and a user-defined port in parallel. Note that this behavior applies only for the HART
protocol (not for the MODBUS protocol).
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5.3.4

MODBUS Protocol
The protocol parameters configure the protocols that run over the serial interface or the
Ethernet interface (HART or MODBUS).
When using the serial interface, only one protocol can be active at a time (either HART or
MODBUS), depending on the value of the serial interface parameter Protocol Selection. See
chapter 5.3.1
When using the Ethernet interface, there is no need to select a protocol. Both protocols run
parallel using different port numbers.

Parameter > Wired Communication > Protocols > Modbus

2017-03

Figure 5.10
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MODBUS Parameters
Parameter

Description

Default

Serial
Bus Address
Selection

Select DIP switches to specify the polling address of the
DIP switches
WirelessHART gateway using the DIP switches inside the
enclosure (see chapter 2.3) or select Software to specify the
polling address in the following field.

Bus Address

If using the software for specifying the polling address, enter 1
the polling address for the WirelessHART gateway. If Bus
Address Selection is set to DIP switches, this parameter is
read only.

Baud Rate
Selection

Select DIP switches to specify the baud rate of the
DIP switches
WirelessHART gateway using the DIP switches inside the
enclosure (see chapter 2.3) or select Software to specify the
baud rate in the following field.

Baud Rate

If using the software for specifying the baud rate, select the
19200
baud rate for the WirelessHART gateway from the drop-down
list. If Baud Rate Selection is set to DIP switches, this
parameter is read only.

Parity Bit

Select the type of parity bit (odd, even or none) that you wish None
to use over the asynchronous serial protocol.

Stop Bit

Select the number of stop bits (1, 1.5 or 2) that you wish to
use over the asynchronous serial protocol.

1

Enter the port number for MODBUS TCP.

502

Ethernet
Port number
Table 5.6

5.3.5

MODBUS Parameters

Emerson AMS Integration
Integration in the Emerson AMS Suite is performed via Ethernet.

Figure 5.11

Parameter > Wired Communication > Protocols > AMS

AMS Parameters
Description

Default

Port number

Enter the port number under which the AMS will address the 33333
WirelessHART gateway.
2017-03

Parameter
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5.4

Diagnostics
The Diagnostics function provides detailed information about the device, wireless/wired
communication and health status.
Note!
Available Only Online (DTM)
If using the configuration via DTM and PACTware the Diagnostics function is available only
online. See chapter 6.4

Accessing the Diagnostics Window
1. If using the DTM and PACTware, right-click the device in the project tree and select Diagnostics.
2. If using the web interface, select Diagnostics in the navigation area on the left.

5.4.1

Identification
Here you find information about the WirelessHART gateway.

Diagnostics > Identification

2017-03

Figure 5.12
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Identification Information
Parameter

Description

Device Long
Tag

Identifies the device in a WirelessHART network.

Device Tag

Identifies the field device within the process plant.

Descriptor

Further description of the device.

Date

User-defined date (e.g. last parameter change). Format: DD.MM.YYYY
The Date parameter is not modified by the WirelessHART gateway. It must be
set by the user or a host application.

Message

User-defined message.

Universal
command
revision

Revision of the universal commands of the device. Only available online.

Device
Revision

Revision of the device-specific commands. Only available online.

Software
Revision

Software revision of the device. Only available online.

Country
Code

Country code of the country in which the device is operated (user-defined).

Assembly
Number

The assembly number of the WirelessHART gateway. Only available online.

Table 5.7

5.4.2

Identification Information

Wireless Communication
Overview
The overview screen provides information about the I/O interfaces of the wireless network as
well as network statistics.

Diagnostics > Wireless Communication > Overview
2017-03

Figure 5.13
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Overview Information
Displayed
Information

Description

I/O System Capabilities
Max. Card
Number

Displays maximum number of cards in the I/O system. This corresponds to
the maximum number of wireless devices that can be connected to the
WirelessHART gateway.

Max. Channel Displays maximum number of channels. The WirelessHART gateway always
Number
returns the value 2.
Max. Sub Dev. Displays maximum number of sub devices that can be connected to a specific
Number
WirelessHART adapter.
Number of
Devices

Displays current number of sub devices. Every device counts as a sub device,
no matter if it is a wireless device or a wired device connected to a
WirelessHART adapter.

Lifetime Network Statistics
Reliability

Percentage of data packets generated by wireless devices that were correctly
received by the WirelessHART gateway.

Stability

Ratio of successful data packet transfers to the total number of data packet
transfers on all wireless paths in the network.

Latency

Average time taken for data packets generated by the wireless devices to
reach the WirelessHART gateway.

Lost upstream Total number of data packets generated by the wireless devices that were lost
packages
when transferred over the network.
Table 5.8

Overview Information

Details
The Details table displays all devices of the WirelessHART network including their diagnostic
information of the last 15 minutes.
Note!
Diagnostic information is available only after a cycle of 15 minutes has been completed. During
this time, some information is set to 0 or replaced by wildcard characters.

2017-03

The diagnostic information represents the last 15 minutes only. Note that for connection paths
with very low traffic, the validity of the diagnostic information can be poor.
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Figure 5.14

Diagnostics > Wireless Communication > Details

To show/hide the index number of a device in the structure, deactivate/activate Tree-View. If
Tree-View is deactivated, the devices are shown in the order they were added to the instrument
list.
If required, click Refresh to reload the diagnostic details of all devices.
Caution!
System failure
If you click Refresh right after the device was switched on or reset, the system may stop
responding.
If the device was switched on or reset, wait about 1 minute until the boot process is complete
before you click Refresh.
Note!
If using the DTM and PACTware to configure the WirelessHART gateway, the following data is
available only during online parameterization.
General Data
Displayed
Information

Description
Displays the long tag of the device.
HART 5 devices and older devices do not support long tags. For those
devices, the WirelessHART adapter uses the content of the Message field
which will be displayed here instead.

I/O Card

Indicates the virtual I/O card number to which the device is mapped to. See
chapter 2.1.3

Channel

Indicates the channel of the virtual I/O card that the device is mapped to. See
chapter 2.1.3
The value 0 identifies a WirelessHART device or a WirelessHART adapter,
while the value 1 identifies a wired device connected to a WirelessHART
adapter.

Device Type

Displays the device type as registered at the HCF.
2017-03

Long Tag
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Displayed
Information

Description

Status

The following communication statuses exist:
communication not possible
communication possible, device not identified
(flashing) communication possible, identification ongoing
device connected and identified

Dev. Status

Note that the device status displayed in the list may differ from the actual
device status because the HART status bits may be interpreted differently.
The following device statuses exist:
maintenance required
out of specification
check function
failure

Diagnostic Information
Parameter

Description

Number of
Joins

Number of times the device has joined the network.

Join Time

Date and time of the most recent join.

Reliability

Percentage of the data packets generated by the wireless devices that were
correctly received by the WirelessHART gateway.

Latency

Average time taken for data packets generated by the wireless devices to
reach the WirelessHART gateway.

+

To show/hide the list of neighboring devices, click the + sign in the + column.

Neighbors

Lists the neighboring WirelessHART devices in reach of the selected device.

RSSI

The RSSI (Received Signal Strength Indicator) indicates the power of the
received signal for each neighboring device. Note that you must expand the
list of neighboring devices in order to see the RSSI value for each device.

Stability

Ratio of successful data packet transfers to the total number of data packet
transfers on all wireless paths in the network.

Table 5.9

Diagnostic Information

To export the diagnostic details to a CSV file, click Export (web interface) resp. Export CSV
(DTM).
For more information on the structure of the CSV file, see chapter 12.

Burst Lists
Normally, a HART slave device only responds when being polled by the host. Burst mode is a
special communication mode in which a HART slave device sends data to a particular HART
command without being polled by the host. When burst mode is used, a HART slave device
can publish data (for example process values) autonomously to another device in regular
intervals. Alternatively, data can be published if the value has changed by a significant amount,
has reached a certain threshold level, or has not been updated within a default reporting time.

2017-03

The WirelessHART gateway maintains a burst message list, which lists the specific commands
that are being published by each device in the WirelessHART network. Note that the burst list is
reset after power-up or network restart.
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Note!
The WirelessHART gateway is able to cache up-to-date device status information only if at
least one command is published in each wireless device. Up-to-date data is important for
efficient device status monitoring. You can find the publishing parameters of most
WirelessHART devices in the Burst Mode menu of the DTM.

Device Publishing Guidelines
■

■

We recommended that you always publish command 48 to ensure caching of the related
status information. A publishing interval of approx. 1 minute is generally the best choice
for wireless devices (not for wired devices).
For example, when configuring WirelessHART adapters, command 48 allows proper
identification and management of changes in the sub-device list without intervention of
the host.
Publishing of at least one command on the wireless device level enables detection of
configuration changes and automatic device cache invalidation without intervention of the
host.

■

Publishing of at least one command also ensures that the cached status information is
updated for cached configuration commands.

■

Short publishing intervals may impair battery life of wireless devices.

Figure 5.15

Diagnostics > Wireless Communication > Burst Lists

To show/hide the index number of a device in the structure, deactivate/activate Tree-View. If
Tree-View is deactivated, the devices are shown in the order they were added to the instrument
list.

2017-03

If required, click Refresh to reload the burst parameters of all devices.
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Caution!
System failure
If you click Refresh right after the device was switched on or reset, the system may stop
responding.
If the device was switched on or reset, wait about 1 minute until the boot process is complete
before you click Refresh.
Note!
If using the DTM and PACTware to configure the WirelessHART gateway, the following data is
available only during online parameterization.
General Data
Displayed
Information

Description

Long Tag

Displays the long tag of the device.
HART 5 devices and older devices do not support long tags. For those
devices, the WirelessHART adapter uses the content of the Message field
which will be displayed here instead.

I/O Card

Indicates the virtual I/O card number to which the device is mapped to. See
chapter 2.1.3

Channel

Indicates the channel of the virtual I/O card that the device is mapped to. See
chapter 2.1.3
The value 0 identifies a WirelessHART device or a WirelessHART adapter,
while the value 1 identifies a wired device connected to a WirelessHART
adapter.

Device Type

Displays the device type as registered at the HCF.

Status

The following communication statuses exist:
communication not possible
communication possible, device not identified
(flashing) communication possible, identification ongoing
device connected and identified

Dev. Status

Note that the device status displayed in the list may differ from the actual
device status because the HART status bits may be interpreted differently.
The following device statuses exist:
maintenance required
out of specification
check function
failure

Burst Parameters
Parameter

Description

+

To show/hide the list of burst messages for a device, click the + sign in the +
column.

Burst
Command

Displays the HART command number and its description.

2017-03

Num. Packets Number of burst messages the device has sent.
Table 5.10

Burst Parameters
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Topology View
The topology view is a graphical overview of all wireless devices within your network, including
their connection status and connection paths. To set up the topology view, go to Engineering >
Topology View. See chapter 5.5.8
The lines between the devices represent the connection paths. The thickness of a connection
path indicates the traffic for this path compared to the total traffic. The color of the connection
path indicates the stability of the connection for this path.
The topology view also displays the path statistic. Move the mouse over a path in order to
display an information box with the following details:
■

Stability

■

Radio signal strength intensity (RSSI)

Move the mouse over a field device in order to display an information box with the following
details:
■

Reliability

■

Latency

Note!
Traffic and stability data is available only after a statistics cycle of 15 minutes has been
completed.
Note that the data that is displayed in the topology view represents a single cycle of 15 minutes
only.
Traffic
Line Style

Description
Dotted lines represent unused paths.
Thin lines represent paths with poor traffic (compared to the total
traffic).
Medium lines represent paths with medium traffic (compared to the
total traffic).

2017-03

Thick lines represent important connection paths with heavy traffic
(compared to the total traffic).
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Stability
Color

Successfully received messages in %
0 - 10
10 - 20
20 - 30
30 - 40
40 - 50
50 - 60
60 - 70
70 - 80
80 - 90
90 - 100

Note!
For paths indicated in black, there is no statistic information available.
Example!

2017-03

In the following example you can see that the devices WHA-ADP-CorrTran and
Test_Dev_598 have no network connection (red status icon and no connection paths) and
thus they are unavailable. Apart from these devices, all other devices are linked with unused
connections (dotted lines), which means that if the main connection fails, the communication
can easily be switched to an alternative, unused connection path.
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Figure 5.16

Diagnostics > Wireless Communication > Topology View

Use the slider to zoom in or out of the topology view. To reset the zoom to its default value, click
Reset Zoom.
Click the devices in the topology view for more information on the device.
If required, click Refresh to reload the device information and rebuild the topology view. Note
that rebuilding the topology view takes some time.
Caution!
System failure
If you click Refresh right after the device was switched on or reset, the system may stop
responding.
If the device was switched on or reset, wait about 1 minute until the boot process is complete
before you click Refresh.
Topology View Parameters
Parameter

Description

Horizontal
Displays the horizontal respectively vertical alignment of the background
image origin image. See chapter 5.5.8
Vertical
image origin
Resolution

Displays the resolution of the background image. See chapter 5.5.8

Paths shown Enables you to select the connection paths that are displayed in the topology
view.
Table 5.11

Topology View Parameters

Display connection paths for a single device
2. Move the cursor over a device in the topology view.
The connection paths are displayed for the select device.
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5.4.3

Wired Communication
The overview screen provides information the host connection of the WirelessHART gateway.
The information is only available when online.

Figure 5.17

Diagnostics > Wired Communication > Overview

Overview Information
Displayed Information

Description

Messages received through HOST

Total bytes received by the host system.

Messages returned to HOST

Total bytes transmitted to the host system.

Number of Requests forwarded to the I/O
system
Number of responses returned from the I/O
system
Overview Information

2017-03

Table 5.12
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Figure 5.18

Diagnostics > Wired Communication > HART

Note!
Not all parameters from the Diagnostics > Wired Communication > HART window are used
by the WirelessHART gateway. In the following table, only the relevant parameters are
described.
Most parameters are transient parameters, which means that they are automatically reset if the
status does no longer apply. The following exceptions have to be reset by pressing Reset
Diagnostic Bits in the Additional Functions > Reset menu.
■ Active Device List changed
More Status Available

■

Configuration Changed

2017-03

■
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HART Parameters
Parameter

Description


Extended Device Malfunction
Manager fault Non-recoverable hardware fault within the manager section of the
WirelessHART gateway.
Non-Volatile
Memory
Defect

Non-recoverable hardware fault within a non-volatile memory area.

Volatile
Memory
Defect

Non-recoverable hardware fault within a volatile memory area.

Ethernet
Non-recoverable hardware fault within the communication controller
Communicatio associated with the Ethernet interface.
n Fault
Electronic
Defect

Non-recoverable hardware fault within the WirelessHART gateway different
from the other faults in the "Extended Device Malfunction" category.

RS-485
Non-recoverable hardware fault within the communication controller
Communicatio associated with the RS-485 interface.
n Fault

Gateway Operation in Progress
Block transfer When the checkbox is activated, this shows that block-transfer activity is
going on in the WirelessHART gateway.
Delayed
answer

When the checkbox is activated, this shows that delayed-answer activity is
going on in the WirelessHART gateway, which can be related either to a buffer
of the WirelessHART gateway or to a buffer of a connected device.

Self-test

This bit is associated with a self-test activity triggered by CMD 41. The
checkbox remains activated until the activity has been completed.

File update

If required, the WirelessHART gateway can write persistent (i.e. non-volatile)
information to its local file system. The checkbox remains activated as long as
information is being written to the file system.

Start-up phase At each power-up or software restart / reset (triggered by CMD 42 & 141), the
WirelessHART gateway polls all devices within the Instrument List to check
their communication statuses and to update their identity information. The
checkbox remains activated until the start-up phase has been completed.

Extended List Changes
Instrument List This checkbox is activated whenever the Instrument List content is changing.
changed
Active Device
List changed

This checkbox is activated whenever the "Active Device list" content is
changing. This is the case when a "communication loss" or a "communication
recovered" event takes place for a device.


Cumulative Device Status
These bits are set to 1 whenever the related status applies to one or more devices (or subdevices) connected to the WirelessHART gateway.
Primary
The PV is beyond its operating limits.
Variable out of
Limits

2017-03

Non-Primary A device variable not mapped to the PV is beyond its operating limits.
Variable out of
Limits
Loop Current
Saturated

The loop current has reached its upper (or lower) endpoint limit and cannot
increase (or decrease) any further.
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Parameter

Description

Loop Current
Fixed

The loop current is being held at a fixed value and is not responding to
process variations.

More status
available

More status information is available via Command 48 (Read Additional Status
Information).

Cold Start

A power failure or device reset has occurred.

Configuration
Changed

An operation was performed that changed the device's configuration.

Device
Malfunction

The device detected a serious error or failure that compromises device
operation.


Cumulative Extended Device Status
These bits are set to 1 whenever the related status applies to one or more devices (or subdevices) connected to the WirelessHART gateway.
Maintenance
Required

One or more wireless devices require maintenance.

Device
Variable Alert

One or more wireless devices have a device variable alert. This bit is set if any
device variable is in alarm or warning state.

Critical Power One or more wireless devices have a power failure (e.g. battery low).
Failure

Device Operation in Progress
These bits are set to 1 whenever the related procedure is ongoing in one or more devices (or
sub-devices) connected to the WirelessHART gateway. When an operation is ongoing, the
WirelessHART gateway will return a "Busy" response code to any HART message of the host
directed to the relevant device (or sub-device). These bits are not latched and simply reflect
the current operation status.
"Configuration The "Configuration Changed bit" procedure is being performed at one or more
Changed bit
devices.
reset"
procedure
"Sub-Device
update"
procedure

One or more sub-devices of WirelessHART adapters are being updated.

"Device
update"
procedure

One or more wireless devices are being updated.

Table 5.13

5.5

HART Parameters

Engineering
The Engineering section consists of the following sections:
■

MODBUS Mapping
You can create the mapping table for the MODBUS input registers manually, semiautomatically, or automatically.
Note that the instrument list must be available before you create the mapping table,
because the values for the mapping table are device-related.
2017-03

■

Instrument List
You can freely define an instrument list of all network components before the devices
actually join the network. Hereby you can make sure that a device is associated with the
predefined I/O card number when the network is reformed or the WirelessHART gateway
is reset.
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■

Topology View
You can upload a background image and arrange the WirelessHART devices in the image
to set up the topology view.
Note that the instrument list must be available before you set up the topology view,
because the set of WirelessHART devices is derived from the instrument list.

WirelessHART Network

CSV file

WirelessHART
Gateway

new devices are
added automatically

2

import device list,
positions, and
background image

number
of devices

Topology View

manual or
semi-automatic
addressing

MODBUS Mapping

import devices

3

import devices

Instrument List
import
automatic
addressing
from device

import
user-defined
addressing

MODBUS Mapping

2017-03

import devices

1

automatic
addressing

Figure 5.19

DTM or
Web Interface

import device list
with IO-card and
channel position

Operating Modes

PACTware®
project tree

device positions, and
background image

Topology View

Relationship between the configuration options in the DTM or web interface and the
data in the WirelessHART gateway

1. The Instrument List you set up via the DTM or the web interface is not necessarily identical to the Operating Modes list of the WirelessHART gateway.
You can set up the Instrument List manually, import an existing list from a CSV file, import
the devices from the PACTware® project tree, or import the devices from the Operating
Modes list of the WirelessHART gateway. You can freely edit the Instrument List in the
DTM or web interface. Once the list of devices and their IO card and channel association
is complete, you can write this information back to the Operating Modes list of the WirelessHART gateway.
The Operating Modes list contains all devices of the WirelessHART network and is constantly updated.
If a new device joins the network, it is automatically inserted into the Operating Modes list.
If the long tag or address of the new device matches an entry from the list, for example, an
entry that you predefined using the Instrument List, the device is associated with the predefined values. If not, it is automatically associated with the next free IO card number and
it will not appear in the Instrument List unless you import the device list from the Operating Modes list.
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2. Before you create the MODBUS Mapping, you must select whether you want to create the
mapping manually, semi-automatically, or automatically:
•

If you select automatic addressing, the mapping is created automatically for all
devices of the Operating Modes list. If new WirelessHART devices appear in the
WirelessHART network, they are automatically added to the Operating Modes list,
and the mapping will also be added automatically.
• If you select manual addressing, you can set up the MODBUS mapping manually
or semi-automatically for all devices of the Instrument List. Note that if a new
WirelessHART device joins the WirelessHART network, it is added to the Operating
Modes list only. Because you selected manual addressing, the automatic
addressing for the devices in the Operating Modes list is disabled and the device
does not automatically appear in the MODBUS Mapping of the WirelessHART
gateway. To set up the mapping for the new device, you must import the new device
into the Instrument List first. After the mapping is complete, you can write the
MODBUS Mapping from the DTM or web interface to the WirelessHART gateway.
3. In the DTM or web interface you can upload a background image and arrange the positions
for all devices of the Instrument List. After you set up the topology view, you can write the
information back to the WirelessHART gateway.
If a new WirelessHART device joins the WirelessHART network, it is inserted at a default
position by the WirelessHART gateway. To rearrange new devices in the DTM or web interface, you can import the new device into the Instrument List or import the device list
from the WirelessHART gateway.

5.5.1

Instrument List
The instrument list is a copy of the Operating Modes list, which is currently active in the
WirelessHART gateway and represents the virtual I/O system of the WirelessHART gateway.
See chapter 2.1.3
Thus, unless the Instrument List is reloaded from the WirelessHART gateway, it may not
necessarily be identical to the Operating Modes list that is currently active in the
WirelessHART gateway.
By creating an instrument list before the devices actually join the network, you can make sure
that a device is associated with a predefined I/O card number when the network is reformed or
the WirelessHART gateway is reset. Note that the instrument list is used for editing the devices
and that the cached values of the devices are located under Measurement. See chapter 5.7
For a detailed overview of the relationship between the configuration options in the DTM or web
interface and the data in the WirelessHART gateway,
see Figure 5.19 on page 63.
Note!

2017-03

This list is stored in a non-volatile memory of the WirelessHART gateway. The card and
channel number assignment will remain the same after a restart of the WirelessHART gateway
or software.
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Figure 5.20

Engineering > Instrument List

Instrument List
Displayed
Information

Description

Long Tag

Long tag of the device
HART 5 devices and older devices do not support long tags. For those
devices, the WirelessHART adapter uses the content of the Message field,
which will be displayed here instead.

I/O-Card

Virtual I/O card number to which the device is mapped to. See chapter 2.1.3

Channel

Channel of the virtual I/O card the device is mapped to.
The value 0 identifies a WirelessHART device or a WirelessHART adapter,
while the value 1 identifies a wired device connected to a WirelessHART
adapter.

Device ID

HART serial number that is assigned at manufacturing time and that differs for
each HART device of a given type. The Device ID is used to build the HART
long frame address.

Ext. Device
Code

Extended device type code of the device
Identifies the HART product family. Each product family is identified by a
unique code.

Table 5.14

Instrument List

Caution!
System failure

2017-03

If you click Refresh right after the device was switched on or reset, the system may stop
responding.
If the device was switched on or reset, wait about 1 minute until the boot process is complete
before you click Refresh.
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Editing the Instrument List
Note!
When editing the instrument list, incomplete entries are highlighted in red. These errors must
be corrected before you can apply the instrument list.
Warnings are highlighted in yellow.
1. To read the Operating Modes list from the WirelessHART gateway using the web interface,
click Refresh. If using the DTM to configure the WirelessHART gateway, select the WirelessHART gateway in the project tree and choose Device > Load from device. If using the
DTM to configure the WirelessHART gateway, you can also import the devices of the project
tree by clicking Import Project Tree (DTM).
2. To add a device, click into the last row of the instrument list and specify the device
parameters. Press Enter to confirm your entries.
You can also edit existing entries by clicking into the corresponding cells of the instrument
list.
3. To remove a device from the instrument list, click the
respective I/O card becomes vacant again.

X-sign at the end of the row. The

4. To write the current instrument list to the WirelessHART gateway using the web interface,
click Apply. If using the DTM to configure the WirelessHART gateway, select the
WirelessHART gateway in the project tree and choose Device > Store to device.
Note that the consistency of the instrument list is not checked before it is applied.
To export the current instrument list to a CSV file, click Export (web interface) resp. Export
CSV (DTM).
To load the instrument list from a CSV file, click Import (web interface) resp. Import CSV
(DTM).
For more information on the structure of the CSV file, see chapter 12.
Tip
If a WirelessHART gateway is replaced with a new one, we recommend that you use the
export/import functionality to transfer the settings from the old WirelessHART gateway to the
new one. Otherwise, the new WirelessHART gateway rebuilds the WirelessHART network from
scratch by default, which means that the virtual HART I/O structure in the instrument list and
the MODBUS addresses of the devices will differ from the positions and addresses that have
been defined in the old WirelessHART gateway.
Furthermore, if using the DTM to configure the WirelessHART gateway, you can prepare the
instrument list and the MODBUS mapping tables offline and export the configuration into a
CSV file. Once the WirelessHART gateway is available on site, you can import the prepared
configuration via the CSV file.

5.5.2

Downstream Communication
The WirelessHART gateway offers a setup for downstream communication for data to be
communicated downstream to field devices for control applications. The follwoing 2 modes are
available:

On-Change Update Mode

The on-change mode is useful if you require to manage many discrete output devices without
frequently changing their output statuses. The on-change mode is based on the reliable
wireless transfer mode.
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By default, all MODBUS output variables are updated with an on-change procedure. That
means, each output status change caused by the MODBUS master is identified by the gateway
and inserted in a queue to be forwarded to the discrete field device as soon as possible.
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Periodic Update Mode
An update period value different from 0 enables the mode: all the specified variables are then
periodically forwarded to the discrete field device.
The update mode is useful if you require to manage a small number of discrete output devices
with frequently changing their output statuses. The on-change mode is based on the best-effort
wireless transfer mode.

5.5.3

Substitution Value
The WirelessHART gateway detects if the last measurement value has gone stale, or the error
limit of the age threshold value is exceeded. You can determine which type of substitution value
should be issued in this case.
You can set one of the following substitution values:
■

Last value

■

NaN1 (0x7FE00000)

■

NaN2 (0x7FA00000)

■

Upscale (ffffff)

■

Downscale (000000)

■

Any user-defined value

Tip
The substitution value can be used to carry through a factory acceptance test. For more
information, see chapter 5.5.7.

Setting Substitution Values
1. In the WirelessHART gateway web interface, go to Engineering > Substitution Value.

Figure 5.21

Engineering > Substitution Value

2. In the field Global Selection select a value from the pulldown list or enter your individual
value in the field.
With a click on Apply, the value is globally set for all field devices.

2017-03

3. Option: If you find that you need deviating substitution values for single field devices,
proceed as follows: Click directly into the Loop Current, PV, SV, TV, or QV cells of the field
devices concerned and enter new suitable single values.
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5.5.4

Security: Access Control List, Temporary Join Key
Whitelist for Access Control
The WirelessHART gateway supports the "whitelist" security mode. The whitelist is an
additional security feature to ensure that only authorized personnel can add a new device. For
example if an external company sets up the network by using this feature, this can help to
ensure that no further changes in consequence of the setup take place.
New WirelessHART devices can only be added to the network provided that their addresses
are listed in the whitelist and can be identified.
If needed, you can manipulate the join key as follows:
■

Change the join key permanently for all devices connected to the network. For more
information on the join key, see chapter 5.2.1.

■

Define a temporary join key that is automatically invalidated after a defined period of time.
This can be used for temporary devices needed for maintenance reasons.

You can monitor the process of this change until the join key has been successfully
manipulated as required.

Defining or Changing a Whitelist
1. Go to Engineering > Security.
2. In order to copy the network to the whitelist, click on Transfer Network to WhitelistA confirmation request dialog opens: The whitelist will be changed. The current whitelist
is flushed and cannot be recovered.
3. Confirm with Yes.
The new devices in the whitelist table are check marked. The whitelist is changed: The
specified devices in the device list below receive a "Whitelisted" check mark (1).
The whitelist is generated.
1

4. Next, set the Network Access Mode pull-down menu from Open to Whitelist and confirm
with OK.

2017-03

Now, only the listed devices that are check-marked as whitelisted can join and re-join the
network. 
Any attempts to enter the network, even with a valid network ID and join key, in order to add
an unauthorized device will be rejected. 
The network is logged.
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Assigning a Temporary Join Key to Add Devices
A temporary join key can be useful for adding devices e. g. from subcontractors for
maintenance purposes within limited periods. This way, you do not need to reveal the regular
join key of your network.
1. In order to open your network: In the Network Access Mode pull-down menu, select Open.
2. Enter the temporary join key. Use the Temporary Join Key Part 1 ... 4 (HEX) fields.
3. Select a Temporary Join Mode Time from the pull-down menu.
During this time, other devices are entitled to join the network. The whitelist preview
grows dynamically as the devices are added to the list.
4. Start the temporary join mode. Use the double arrow buttons to Start Temporary Join
Mode.
5. Copy devices to the whitelist and close the network again. See section "Defining or
Changing a Whitelist" above.

5.5.5

MODBUS Mapping
MODBUS Settings
Here you can define several MODBUS settings and choose between automatic or manual
MODBUS mapping.

Engineering > Modbus Mapping > Modbus Settings

2017-03

Figure 5.22
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MODBUS Parameters
Parameter

Description

Swap Option Enables you to select the Big Endian or Little Endian swap option. Note that
this setting affects both automatic and manual addressing of the MODBUS
registers.
In the following examples a word32 [ 0xABCD ] is stored into MODBUS
registers using different swap options.
Big Endian: no register swap
Registers: Big Endian
Source bytes: [ 0xABCD ]
Target bytes: reg_0: [ 0xAB ] reg_1: [ 0xCD ]
Little Endian: register swap
Registers: Little Endian
Source bytes: [ 0xABCD ]
Target bytes: reg_0: [ 0xCD ] reg_1: [ 0xAB ]
Addressing
Method

Enables you to select Auto or Manual addressing of the MODBUS registers.
Note that the Manual option also includes semi-automatic addressing.
■ If Auto addressing is enabled, the submenus Input Status and Input
Register are disabled and you cannot edit the MODBUS mapping
manually. The mapping is created automatically for all devices of the
Operating Modes list. If new WirelessHART devices appear in the
WirelessHART network, they are automatically added to the Operating
Modes list, and the mapping will also be added automatically. See
chapter 5.5.5.
■

Read
Modbus
Registers
Mode
Table 5.15

If Manual addressing is enabled, you can use the submenus Input Status
and Input Register to set up the MODBUS mapping manually or semiautomatically for all devices of the Instrument List. If a new
WirelessHART device joins the WirelessHART network, it is added to the
Operating Modes list only. The new device will not appear in the
Instrument List unless you import the device list from the Operating
Modes list. See chapter .

Enables you to define the read mode for the MODBUS master. You can select
between Input and Holding and Input Registers only. If you select Input
and Holding, MODBUS masters that do not support the reading of input
registers can read through the holding registers.
MODBUS Parameters

For a detailed overview of the relationship between the configuration options in the DTM or web
interface and the data in the WirelessHART gateway,
see Figure 5.19 on page 63.
Tip
If you replace a WirelessHART gateway with firmware version 2.4 or older, we recommend that
you select Auto from the Addressing Method drop-down list.

MODBUS Implementation
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■

The HART CMD 3 dynamic variables are used for MODBUS mapping.

■

For MODBUS access, CMD 3 publishing must be enabled for all relevant devices.

■

The WirelessHART gateway caches the relevant CMD 3 information. MODBUS
commands will therefore access the internal memory of the WirelessHART gateway.

■

MODBUS input registers are only supported if they are associated with HART dynamic
input variables.

2017-03

The MODBUS implementation maps HART dynamic input variables to MODBUS input
registers and uses input registers to provide device-related status information. The MODBUS
implementation is based on the following assumptions:

WHA-GW-F2D2-0-A*-Z2-ETH
Configuration via Web Interface

■
■

A device can either be a WirelessHART device or a wired HART device connected to a
WirelessHART adapter.
WirelessHART and wired HART devices are mapped independently within the MODBUS
input registers. Wired devices are not necessarily mapped consecutive with the
associated WirelessHART adapter.

Standard Compliance

MODBUS RTU

MODBUS TCP

Physical layer

RS-485

Ethernet

Data transfer mode

RTU (binary mode)

–

Baud rates

1200 bps, 2400 bps,
4800 bps, 9600 bps,
19200 bps, 38400 bps,
57600 bps, 115200 bps

–

Parity

Odd, Even, None

–

Stop bits

1; 1.5; 2

–

Polling address

1 ... 247

–

Capabilities

■

Input registers starting at MODBUS address 30001

■

HART CMD 3 dynamic variables mapped into input
registers

■

2 input registers map a single HART dynamic variable

■

32-bit HART floating point format used

■

Status information mapped on dedicated input registers

You can define the parameters for the MODBUS protocol under Parameter > Wired
Communication > Protocols > Modbus. For more information, see chapter 5.3.4.
The MODBUS implementation allows to map dynamic variables and device variables as well
as diagnostic and status information to MODBUS registers. The MODBUS implementation
allows the usage of following register types:
Coil and Holding Register
Digital

Analog

IN

Input status

Input register

OUT

Coil

Output register/Holding
register

The source or sink of the information can be one of the following components: a WirelessHART
device, a WirelessHART adapter, or a wired field device connected to a WirelessHART
adapter. All information required for the MODBUS communication in Input Registers or Input
Status must be bursted by the field devices. The WirelessHART gateway caches all the bursted
information and maps it to the MODBUS registers depending on the required setup. The
gateway distributes all information used in Coil either upon a change or in a selected interval.
For more information, see chapter 5.5.2.

Mapping Format of HART Dynamic Variables

2017-03

For each HART device, the 5 possible CMD 3 floating-point dynamic variables are sequentially
mapped (the CMD 3 units code values are not mapped). If a device does not support a specific
dynamic value, a NaN (Not a Number) floating-point value is returned (namely 0x7F, 0xA0,
0x00, 0x00).
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The CMD 3 dynamic variables follow the IEEE-754 (IEC 559) single-precision floating-point
format:
Sign of the Fraction

8-bit Exponent

23-bit Fraction

The same format is also used for the MODBUS 32-bit floating point values.
The MODBUS protocol does not explicitly specify any 32-bit data element. However, the usage
of 2 consecutive 16-bit registers is the de-facto standard way to map a single-precision IEEE754 floating-point value. Note that the MODBUS floating value will be transmitted in Big
Endian style. For example, the number 123456.00 as defined in the IEEE-754 standard
appears as follows:
Byte 0

Byte 1

Byte 2

Byte 3

0x00

0x20

0xF1

0x47

This number will be transmitted from the WirelessHART gateway to the MODBUS master in the
following sequence: 47 F1 20 00 where 00 is the less significant byte, which is transmitted in
first place.

Mapping Format of HART Discrete Variables
Discrete variables can have one of three formats:
■

Packed: 16 independent Boolean values, packed into 2 bytes.

■

State: single enumeration value stored as an – unsigned – 16-bit integer.

■

Arithmetic/Counter: a single continuous calculated value stored as an – unsigned – 16-bit
integer.

Note!
Discrete Variables: User/Host Application Responsibilities
■ It is up to the host application recognize the format of a specific discrete variable and to
decode and use its value correctly. 
The gateway can never verify or analyze the internal format of a discrete variable!
■

It is up to the host application to recognize the capabilities of each specific device whe it
comes to the support of discrete variables. 
The gateway cannot check if or how many discrete variables are supported by a device!

In order to map a discrete variable to a MODBUS register, you need to specify the index of the
variable.
■ The discrete variable index does not provide any information on the variable format.
■

The arithmetic/counter values are mapped in the same way as state values.

Input Variables Mapping
Packed values mapping
Packet input values are intended be mapped on discrete input MODBUS registers. You are
required to verify that the discrete variable to be mapped actually has an input value with a
packet format.
Packet input values must be mapped 1 byte at a time, i. e., the minimum mapping unit consists
of 8 Boolean values, as stored in the LSB or MSB part of the discrete variable.

2017-03

MODBUS discrete input registers consist of a single bit. In order to preserve the byte
alignment, the register number used for mapping must always refer for the 1st bit within a byte
(0, 8, 16, 24 …).
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State values mapping
State input values are intended be mapped onto input MODBUS registers. You are required to
verify that the discrete variable to be mapped actually has an input value with a state format.
A state input value (16 bits) is always mapped onto a single input register (16 bits).
Output Variables Mapping
Packed values mapping
Packet output values are intended be mapped onto coils MODBUS registers. You are required
to verify that the discrete variable to be mapped actually has an output value with a packet
format.
Packet output values must be mapped 1 byte at a time, i. e., the minimum mapping unit
consists of 8 Boolean values, as stored in the LSB or MSB part of the discrete variable.
MODBUS coils registers consist of a single-bit. In order to preserve the byte alignment, the
register number used for mapping must always refer for the 1st bit within a byte
(0, 8, 16, 24 …).
Note!
Output Variables Mapping: User/Host Application Responsibilities
You can still map state values on a different MODBUS register type, i. e., on the holding
register.
However, you are required to ensure the correct behavior of the MODBUS master.
State values mapping
State output values are intended be mapped onto holding MODBUS registers. You are required
to verify that the discrete variable to be mapped actually has an output value with a state
format.
A state output value (16 bits) is always mapped onto a single holding register (16 bits).

Automatic Mapping of MODBUS Input Registers
Each HART device is mapped on 12 consecutive MODBUS input registers. The input registers
can be read using MODBUS function code 04 (Read Input Registers). In general, the
information about the WirelessHART gateway is mapped on registers 30001 ... 30012. The
first device is mapped on register 30013, the second starting at register 30025, and so on.
The order of the HART device mapping starting from register 30001, is the same as the order of
the HART devices returned by the command 84 (HART CMD 84, Read Sub-Device Identity
Summary). For example, the HART device that you can read by using CMD 84 with the subdevice index = 1 is mapped starting at register 30013. The device that you can read by using
CMD 84 with the sub-device index = 2 is mapped starting at register 30025 and so on.
To find out the starting register of a certain sub-device, use the following formula:
SIR = 30001 + 12*(SDI) where SIR is the starting input register of the associated HART device
and SDI is the CMD 84 sub-device index value.

2017-03

The following table shows the exemplary mapping of the first 2 HART devices, for example the
ones associated with SDI = 1 and SDI = 2.
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SubDevice
Index
(CMD 8
4)

MODBUS
Register

Value

Description

Format

30013

30014

AI

Primary variable
(loop current, mA unit)

30015

30016

PV

Primary variable
(device-specific unit, see the manual of the
sub-device for more information on the
device-specific unit codes)

32-bit
1
floating
point

30017

30018

SV

Secondary variable
(device-specific unit, see the manual of the
sub-device for more information on the
device-specific unit codes)

30019

30020

TV

Tertiary variable
(device-specific unit, see the manual of the
sub-device for more information on the
device-specific unit codes)

30021

30022

QV

Quaternary variable
(device-specific unit, see the manual of the
sub-device for more information on the
device-specific unit codes)

30023

–

ModStat MODBUS-specific status
See chapter 12.2

30024

–

DevStat HART device status
See chapter 12.1

30025

30026

AI

Primary variable
(loop current, mA unit)

30027

30028

PV

Primary variable
(device-specific unit, see the manual of the
sub-device for more information on the
device-specific unit codes)

30029

30030

SV

Secondary variable
(device-specific unit, see the manual of the
sub-device for more information on the
device-specific unit codes)

30031

30032

TV

Tertiary variable
(device-specific unit, see the manual of the
sub-device for more information on the
device-specific unit codes)

30033

30034

QV

Quaternary variable
(device-specific unit, see the manual of the
sub-device for more information on the
device-specific unit codes)

30035

–

ModStat MODBUS-specific status
See chapter 12.2

30036

–

DevStat HART device status
See chapter 12.1

16-bit
unsigne
d
integer
32-bit
2
floating
point

2017-03

16-bit
unsigne
d
integer
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Manual MODBUS Mapping for Input Status and Input Register
Note!
Manual or semi-automatic creation of the mapping table for the MODBUS input registers is
available only if the Addressing Method under Engineering > Modbus Mapping > Modbus
Settings is set to Manual. See chapter
The Instrument List must be available before you create the mapping table, because the
values for the mapping table are retrieved from the Instrument List.
For a detailed overview of the relationship between the configuration options in the DTM or web
interface and the data in the WirelessHART gateway,
see Figure 5.19 on page 63.
The Input Status submenu enables you to map discrete variables on the MODBUS input
registers.
The Input Register submenu enables you to map HART variables and device-specific status
information on the MODBUS input registers.
In both submenus, you have the following options:
■
■

You can create the mapping table manually.
For more information, see the subsection Create MODBUS Mapping Manually.
You can create the mapping table semi-automatically, which means that the mapping
table is generated automatically according to your specifications.
For more information, see the subsection Create MODBUS Mapping Semi-Automatically.

Create MODBUS Mapping Manually
The Table tab enables you to create or edit the MODBUS mapping table manually.
Note!
The Instrument List must be available before you create the mapping table, because the
values for the mapping table are retrieved from the Instrument List.

2017-03

For a detailed overview of the relationship between the configuration options in the DTM or web
interface and the data in the WirelessHART gateway,
see Figure 5.19 on page 63.

Figure 5.23

Engineering > Modbus Mapping > Input Status/Input Register: Manual Editing Table
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Table Parameters
Parameter

Description

Register/End MODBUS registers into which the value is mapped.
register
Long Tag

Long Tag of the device
HART 5 devices and older devices do not support long tags. For those devices, the
WirelessHART adapter uses the content of the Message field, which will be displayed here
instead.

Card

Virtual I/O card number to which the device is mapped to.
For more information, see chapter 2.1.3.

Channel

Channel of the virtual I/O card the device is mapped to. The value 0 identifies a WirelessHART
device or a WirelessHART adapter, while the value 1 identifies a wired device connected to a
WirelessHART adapter.
For more information, see chapter 2.1.3.

Value

Indicates the value that is read from the device and mapped to the MODBUS registers.
The Input Status submenu enables you to map the following values:
■ Lower Significant Byte: If you select Lower Significant Byte, enter a response byte as
well.
■

Most Significant Byte: If you select Most Significant Byte, enter a response byte as well.

Table 5.16
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■

Percent Range

■

PV: HART primary variable

■

SV: HART secondary variable

■

TV: HART tertiary variable

■

QV: HART quaternary variable

■

Device Variable: The device variable provides device-specific information. This information
is displayed using a device-specific unit code.
For more information on what device-specific information is available and on the devicespecific unit codes, see the manual of the sub-device.

■

Battery Life

■

Slot 0 Data Time Stamp: Time stamp calculated by the device for the slot 0 returned
through CMD 9. Whenever the gateway receives a response/burst of CMD 9, it updates that
mapped value.

■

Device Status
For more information, see chapter 12.1.

■

Extended Device Status
For more information, see chapter 12.1.

■

Device Status & Extended Device Status

■

CMD 48 Device Status
If you select CMD 48 Device Status, specify a response byte as well.
For more information, see chapter 12.1.

■

State Variables:: Discrete state variables. The packed variables can be mapped on the input
status.

■

PV Stale Status

■

SV Stale Status

■

TV Stale Status

■

QV Stale Status

■

PV Percentage Age

■

SV Percentage Age

■

TV Percentage Age

■

QV Percentage Age

■

Device Variable Status: HART status of indexed device variable as returned by the device.

■

All CMD 48 Device States

■

Modbus Status
For more information, see chapter 12.2.

Table Parameters
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The Input Register submenu enables you to map the following values:
■ Loop Current
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Caution!
System failure
If you click Refresh right after the device was switched on or reset, the system may stop
responding.
If the device was switched on or reset, wait about 1 minute until the boot process is complete
before you click Refresh.

Create MODBUS Mapping Manually
Note!
When editing the mapping table, mapping errors or duplicate address allocations are
highlighted in red. These errors must be corrected before you can apply the MODBUS
mapping.
Warnings are highlighted in yellow.
1. To read the current mapping from the WirelessHART gateway using the web interface, click
Refresh. If using the DTM to configure the WirelessHART gateway, select the WirelessHART gateway in the project tree and choose Device > Load from device.
2. On the Table tab, go to the row in the mapping table that contains free input registers that
have not been mapped yet.
3. Click into the Long Tag cell and select a device from the drop-down list.
We recommend that you map the values of the WirelessHART gateway on the first registers.
4. Click into the Value cell and select a value you want to read.
Note that if you select CMD 48 Device Status, Lower Significant Byte, or Most
Significant Byte, you must enter a response byte as well.
5. After you selected the device and value, press Enter to confirm.
The Register, Endregister, Card, and Channel values are updated automatically and a
new line for the remaining registers is inserted automatically.
6. Repeat these steps to complete the mapping table.
7. To write the current mapping table to the WirelessHART gateway using the web interface,
click Apply. If using the DTM to configure the WirelessHART gateway, select the
WirelessHART gateway in the project tree and choose Device > Store to device.
Note that the new mapping is applied immediately and the consistency of the mapping table
is not checked before it is applied.
To export the current mapping table to a CSV file, click Export (web interface) resp. Export
CSV (DTM).
To load the mapping table from a CSV file, click Import (web interface) resp. Import CSV
(DTM).
For more information on the structure of the CSV file, see chapter 12.3.
To delete a mapping entry, click the

X-sign in the table header.
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table, click the

X-sign at the end of line. To delete the entire mapping
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Tip
If a WirelessHART gateway is replaced with a new one, we recommend that you use the
export/import functionality to transfer the settings from the old WirelessHART gateway to the
new one. Otherwise, the new WirelessHART gateway rebuilds the WirelessHART network from
scratch by default, which means that the virtual HART I/O structure in the instrument list and
the MODBUS addresses of the devices will differ from the positions and addresses that have
been defined in the old WirelessHART gateway.
Furthermore, if using the DTM to configure the WirelessHART gateway, you can prepare the
instrument list and the MODBUS mapping tables offline and export the configuration into a
CSV file. Once the WirelessHART gateway is available on site, you can import the prepared
configuration via the CSV file.

Create MODBUS Mapping Semi-Automatically
The Generate tab enables you to generate the mapping table automatically according to your
specifications. You only need to select the values you want to read from the devices. After this
selection has been completed, you can generate the mapping table for all devices
automatically.
Note!
The Instrument List must be available before you create the mapping table, because the
values for the mapping table are retrieved from the Instrument List.
For a detailed overview of the relationship between the configuration options in the DTM or web
interface and the data in the WirelessHART gateway,
see Figure 5.19 on page 63.

Engineering > Modbus Mapping > Input Status/Register: Semi-Automatic Generation

2017-03

Figure 5.24
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Generation Parameters
Parameter

Description

Start Register The first MODBUS register into which the first value is mapped.
Generation
order

Value

The generation order defines the order in which the HART devices will be mapped on the
MODBUS input registers.
■ Index
The devices are mapped according to the index number. To look up the index numbers, you
can deactivate the Tree-View check box under Diagnostics > Wireless Communication >
Details.
■

Alphabetical
The devices are mapped in alphabetical order, according to the Long Tag of the wireless
device.

■

Alphabetical (sub-device)
The devices are mapped in alphabetical order, according to the Long Tag of the sub-device.

■

IO card & channel
The devices are mapped according to the IO card & channel number of the wireless device.

■

IO card & channel (sub-device)
The devices are mapped according to the IO card & channel number of the sub-device.

Enables you to define the values you want to read as well as their sequence.
Click into the Value column to select a value from the drop-down list.
The Input Status submenu enables you to map the following values:
■ Lower Significant Byte: If you select Lower Significant Byte, enter a response byte as
well.
■

Most Significant Byte: If you select Most Significant Byte, enter a response byte as well.

The Input Register submenu enables you to map the following values:
■ Loop Current
■

Percent Range

■

PV: HART primary variable

■

SV: HART secondary variable

■

TV: HART tertiary variable

■

QV: HART quaternary variable

■

Device Variable: The device variable provides device-specific information. This information
is displayed using a device-specific unit code.
For more information on what device-specific information is available and on the devicespecific unit codes, see the manual of the sub-device.

■

Battery Life

■

Device Status
For more information, see chapter 12.1.

■

Ext. Device Status
For more information, see chapter 12.1.

■

Device Status & Extended Device Status

■

CMD 48 Device Status
If you select CMD 48 Device Status, specify a response byte as well.
For more information, see chapter 12.1.

■

All CMD 48 Device States

■

Modbus Status
For more information, see chapter 12.2.

Default
settings

Generates a default mapping table that corresponds to the Automatic mapping. For more
information on the automatic mapping rules, see chapter 5.5.5.

Generate

Writes the mapping to the table on the Table tab, according to your selections on the Generate
tab.

Delete all
Mappings

If activated, the mapping you generate overwrites all existing mappings on the Table tab.
If deactivated, the mapping you generate is added to existing mappings on the Table tab.

Generation Parameters

2017-03

Table 5.17
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Generate MODBUS Mapping
1. On the Generate tab, enter the start register for the MODBUS mapping in the Start register
field.
2. Select the order in which the devices are mapped on the MODBUS registers in the
Generation order drop-down list.
3. Select the values you want to read for each device in the Value column.
Note that if you select CMD 48 Device Status, Lower Significant Byte, or Most
Significant Byte, you must enter a response byte as well.
4. If required, activate the Delete all Mappings check box to overwrite any existing mappings
on the Table tab. If deactivated, the mapping you generate is added to existing mappings on
the Table tab.
5. Click Generate to write the mapping to the table on the Table tab.
6. Click Table.
The mapping table on the Table tab displays the generated mappings.
7. If required, you can manually edit the generated mapping table.
For more information, see Create MODBUS Mapping Manually.
8. To write the current instrument list to the WirelessHART gateway using the web interface,
click Apply. If using the DTM to configure the WirelessHART gateway, select the
WirelessHART gateway in the project tree and choose Device > Store to device.
Note that the consistency of the instrument list is not checked before it is applied.
To export the current mapping table to a CSV file, click Export (web interface) resp. Export
CSV (DTM).
To load the mapping table from a CSV file, click Import (web interface) resp. Import CSV
(DTM).
For more information on the structure of the CSV file, see chapter 12.3.
To delete a mapping entry, click the
table, click the

X-sign at the end of line. To delete the entire mapping

X-sign in the table header.

Tip
If a WirelessHART gateway is replaced with a new one, we recommend that you use the
export/import functionality to transfer the settings from the old WirelessHART gateway to the
new one. Otherwise, the new WirelessHART gateway rebuilds the WirelessHART network from
scratch by default, which means that the virtual HART I/O structure in the instrument list and
the MODBUS addresses of the devices will differ from the positions and addresses that have
been defined in the old WirelessHART gateway.
Furthermore, if using the DTM to configure the WirelessHART gateway, you can prepare the
instrument list and the MODBUS mapping tables offline and export the configuration into a
CSV file. Once the WirelessHART gateway is available on site, you can import the prepared
configuration via the CSV file.

5.5.6

Stale Value Detection (Early Warning)
The web interface offers the configuration of notification limits in case the value of a cached
dynamic variable or the command 48 status information of a wireless device is going stale. This
way, you are informed promptly in case the variable or information is not updated at the
expected rate, i. e., at the burst rate of the field device.

2017-03

The WirelessHART gateway reads the expected burst rates from each field device and "timestamps" each burst message at the time of receipt. This way, the age of each cached value can
be calculated as a percentage value of the existing burst rate.
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From this information, the WirelessHART gateway can determine whether a message is
overdue or not: The gateway starts to count the age of the last sent value until the gateway
receives the next value from the field device and then starts to count again, and so on.
Tip
Provided that the field devices have reasonable burst rates, the specification of age threshold
limits enable you to detect communication loss very early.

Example
You can define a warning and an error limit, e. g., 150 % and 300 % of the age threshold value.
A burst alarm is generated if these defined values are exceeded. In the Measurement List of
the web interface, you can check the age of the age threshold value. In this menu, the gateway
indicates the age threshold value in percent in the colors green (on time), yellow (overdue), and
red (error).
■
■

■

Good value: Value is no older than 150 % of the burst rate. The value is indicated in
green.
Age Threshold Warning: Value has exceeded 150 % of the burst rate in this example.
The value is indicated in yellow.
The warning limit is typically used to identify temporary communication problems.
Age Threshold Error: Value has exceeded 300 % of the burst rate in this example. The
value is indicated in red.
The age threshold error limit is typically used to indicate a - likely - complete loss of the
device, e. g., due to a battery removal. In case of an error condition, it is possible to set
additional individual substitution values for each variable for application-related failure
handling. For more information, see chapter 5.5.3.

Setting Age Threshold Values
1. In the web interface, go to Engineering > Substitution Value.

Figure 5.25

Engineering > Substitution Value, setting the age threshold values

2. In the field Global Age Threshold Warning enter a global limit value for all field devices as
a percentage of the existing burst rate.
3. In the field Global Age Threshold Error enter a global limit value for all field devices as a
percentage of the existing burst rate.
Click on Apply, to set the percentage values globally for all field devices.
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4. In order to set values individually: Directly click into the Age Threshold Warning and Error
cells of the field devices concerned and enter suitable individual values.
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Viewing the Age Threshold Value Status
In the WirelessHART gateway web interface, go to Engineering > Measurement List.

Figure 5.26

5.5.7

Engineering > Measurement List, viewing the age threshold value limits

Network Setup: Factory Acceptance Test
The factory acceptance test is a simulation to check whether the distributed control system
(DCS) receives the correct values from the WirelessHART gateway. During the simulation the
substitution values that were defined for the field devices are used to be sent to the DCS. The
simulation is successful if the DCS receives the substitution values as expected.
Tip
Use the factory acceptance test to easily check the data transmission from the gateway to the
DCS without starting up a network first.

Carrying Out a Factory Acceptance Test
Without the network, the field devices do not communicate with the WirelessHART gateway
yet.
1. Generate a MODBUS mapping. For more information, see chapter 5.5.5, section "Manual
MODBUS Mapping for Input Status and Input Register".
2. Define a substitution value. For more information, see chapter 5.5.3.

5.5.8

If the gateway receives the substitution value in the DCS, the factory acceptance test is
successful.

Topology View

Here you can set up the topology view that is displayed under Diagnostics > Wireless
Communication > Topology View. You can upload background images in any common
graphic format, such as JPG or GIF. For example, you can use a satellite photo, a floor plan, or
a diagram in which you want to group the devices
Note!
The Instrument List must be available before you set up the topology view, because the set of
WirelessHART devices is derived from the Instrument List. See chapter 5.5.1
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For a detailed overview of the relationship between the configuration options in the DTM or web
interface and the data in the WirelessHART gateway,
see Figure 5.19 on page 63.
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Figure 5.27

Engineering > Topology View

Caution!
System failure
If you click Refresh right after the device was switched on or reset, the system may stop
responding.
If the device was switched on or reset, wait about 1 minute until the boot process is complete
before you click Refresh.
Note!
Required Display Resolution for the Topology View
In order to guarantee a fully visible, undistorted, and uncropped background image, we
recommend to set the display resolution to a 4:3 proportion within the following pixel resolution
range:
800 x 600 ... 1600 x 1200

Set Up the Topology View
1. To retrieve the devices from the Operating Modes list of the WirelessHART gateway using
the web interface, click Refresh. If using the DTM to configure the WirelessHART gateway,
select the WirelessHART gateway in the project tree and choose Device > Load from device. Note that reloading the device information takes some time.
2. Click Select Map to select a background image for the topology view.
3. Click Browse to select the background image.
4. Click Upload Map to upload the background image.
5. If required, edit the coordinates of the image origin in the Horizontal image origin and
Vertical image origin boxes.
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6. Enter a value in the Resolution box to scale the background image, for example 1 m/pixel.
Note that you can set the resolution only after you have uploaded an image.
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7. Arrange the WirelessHART devices in the topology view by dragging and dropping the
devices to a selected position. Note that for a more accurate positioning you can use the
slider to zoom in or out of the topology view. To reset the zoom to its default value, click
Reset Zoom.
8. To write the current topology view to the WirelessHART gateway using the web interface,
click Apply. If using the DTM to configure the WirelessHART gateway, select the
WirelessHART gateway in the project tree and choose Device > Store to device.
To export the current devices and their positions to a CSV file, click Export (web interface)
resp. Export CSV (DTM).
To load a list of devices and their positions from a CSV file, click Import (web interface) resp.
Import CSV (DTM).
For more information on the structure of the CSV file, see chapter 12.

5.6

Additional Functions
Accessing the Additional Functions Window
1. If using the DTM and PACTware, right-click the device in the project tree, select Additional
functions and choose the desired function.
2. If using the web interface, select Additional Functions in the navigation area on the left.

5.6.1

Print Engineering Menu
In the DTM, all the settings of the WirelessHART gateway Engineering menu can be printed
out. This provides a quick and easy way to get a printout of the instrument list, the MODBUS
mapping, or the network properties, etc.

Printing the Engineering Menu
In the DTM select Device > Print

5.6.2

Set DTM Address
The table in the Set DTM address window shows the WirelessHART devices configured in the
PACTware project and their DTM addresses. The DTM address is the device long tag as
specified in the DTM of the device (offline data record). The DTM address is also displayed in
the project tree structure of the PACTware project.
Note!

Figure 5.28
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The Long Tag parameterized in the Set DTM Address window must be identical with the
Long Tag of the same device parameterized in the Set device address window. See chapter
5.6.3
Otherwise the DTM is not able to establish a connection to the device.
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Changing the DTM address
1. Place the cursor inside a cell of the Long Tag column.
2. Change the device long tag as required. You may change the long tags of several devices at
once, if needed.
3. Close the DTM dialogs of the devices whose long tags are to be changed.
4. To apply the new DTM address(es) press Update changed tags.

5.6.3

The new DTM addresses are displayed in the project view of PACTware.

Set Device Address

The table in the Set device address window shows the WirelessHART devices in the network.
The device address is the device long tag stored in the device.
Note!
Additional functions > Set device address is available only online, while the connection to
the WirelessHART gateway and the WirelessHART device(s) is active.
Note!
The Long Tag parameterized in the Set Device Address window must be identical with the
Long Tag of the same device parameterized in the Set DTM address window. See chapter
5.6.2
Otherwise the DTM is not able to establish a connection to the device.

Figure 5.29

Additional Functions > Set device address

Changing the device address
1. Place the cursor inside a cell of the Long Tag column.
2. Change the device long tag as required. You may change the long tags of several devices at
once, if needed.
3. To apply the new DTM address(es) press Update changed tags.
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The new DTM addresses are stored to the devices.
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5.6.4

Device Reset

Figure 5.30

Additional Functions > Device Reset

Reset Options
Parameter

Description

Device Reset Restarts the software of the WirelessHART gateway without any impact on the
established network (which is not reformed).
This function does not set the parameters of the WirelessHART gateway back
to their default values. It restarts the WirelessHART gateway software only.
Rebuild
Instrument
List

Regenerates the instrument list from scratch.
The existing instrument list is overwritten. Note that the MODBUS addresses
of the devices in the network will be changed by resetting the instrument list.
We recommend that you create a backup of the current instrument list before
rebuilding a new instrument list. See chapter 5.5.1

Reform
Network

Restarts and re-establishes the network. For example, this function is needed
to activate a new network ID. See chapter 5.2.1
Depending on the size of the network, this process may take several minutes.
This function does not set the parameters of the WirelessHART gateway back
to their default values. It restarts the network only.

Reset
Diagnostic
Bits

Resets the HART parameters under Diagnostics > Wired Communication
> HART to its default values.

Table 5.18

5.6.5

Reset Options

Self Test
After pressing the Perform Self-Test button in the Additional Functions > Self Test menu the
device carries out a self test.
The results of the self test can be seen in the Diagnostics menu. See chapter 5.4

About
Additional Functions > About displays information about the device, its manufacturer, and its
firmware version.

86

2017-03

5.6.6

WHA-GW-F2D2-0-A*-Z2-ETH
Configuration via Web Interface

5.6.7

Firmware Upgrade
Note!
This configuration option is only available in the web interface.

Figure 5.31

Additional Functions > Firmware upgrade

Upgrading the Firmware
1. Choose Additional Functions > Firmware Upgrade.
2. Click Browse to choose the firmware upgrade package (*.ipk) from your hard drive.
3. Click Upload the Package.
4. To install the firmware upgrade, press Install the Package. You can also abort the upgrade
process by clicking Discard Upgrade.
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The installation process may take a while. When the installation is finished, Installation
Successfully Completed is displayed.
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5.6.8

Change Password
Note!
This configuration option is only available in the web interface.

Figure 5.32

Additional Functions > Change Password

The connection to the web interface is made using a secure connection (HTTPS) which
requires a user name and a password. The factory default settings are:
User name: admin
Password: admin
You can change both user name and password in the web interface.

Changing the Password
1. Log on to the web interface of the WirelessHART gateway using the user name for which you
want to change the password.
2. Choose Additional Functions > Change Password.
3. Enter a new password into the corresponding fields.
4. To apply the new password, click Change Password. You can also abort the operation by
clicking Discard Operation.

2017-03

The password for the current user has been changed.
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5.6.9

Upload Certificate for HTTPS Connection
You can install a trusted certificate issued by a certification authority, such as TC TrustCenter,
Thawte, or VeriSign.
A digital certificate is an electronic document that binds a public key with an identity, for
example, an organization or an user. The binding between a public key and the identity is done
by a signature. This signature can be self-signed or authenticated by a certification authority.
The WirelessHART gateway is delivered with a self-signed certificate for the HTTPS
connection. Because the web browser cannot verify the authenticity of a self-signed certificate,
some web browsers display the following (or a similar) warning message in the address bar:

Note!
This configuration option is only available in the web interface.

Figure 5.33

Additional Functions > Upload Certificate

Install a Trusted Certificate
Note!
Prerequisites:
■ You need a certificate and a private key from a trusted authority, such as TC TrustCenter,
Thawte, or VeriSign.
■

Both files must comply with the following standard: X.509 Ver. 3

1. Click Browse and select the certificate file from the certification authority.
2. Click >> to upload the certificate.
The Upload Private Key option appears.
2017-03

3. Click Browse and select the private key from the certification authority.
4. Click >> to upload the private key.
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The Change Certificate and Private Key option appears.
5. Click >> to install the certificate and private key.

Figure 5.34

Installation confirmation

6. Go to Additional Functions > Device Reset and perform a device reset for the changes to
take effect.
If the trusted certificate has been installed successfully, the address bar in the web browser
displays a padlock icon:

This indicates that the web interface of the WirelessHART gateway is a trusted site.

5.6.10

Auto Refresh
All the parameter values of the WirelessHART gateway web interface and DTM are
automatically refreshed at a default interval of 60 s.

Figure 5.35

Additional Functions > Auto Refresh

Adjusting or Deactivating Auto Refresh
Select Auto refresh and choose a setting between 10 s ... 60 min. 
Alternatively deselect Auto refresh altogether if required.

5.7

Measurement
The measurement list displays a comprehensive overview of all cached parameters and values
of all sub devices.
This list is stored in a non-volatile memory of the WirelessHART gateway. The card and
channel number assignment will remain the same after a restart of the WirelessHART gateway
or software.
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Note!
Please keep in mind that the dynamic values of each sub device (analogue value, PV, SV, TV,
QV) are cached by the WirelessHART gateway only if the respective sub device publishes
those values. See chapter 2.1.4
After a network restart, the Operating Modes list needs time to rebuild. During this time, some
information is set to 0 or replaced by wildcard characters.

Figure 5.36

Measurement List

If required, click Refresh to reload the values of all sub devices.
Caution!
System failure
If you click Refresh right after the device was switched on or reset, the system may stop
responding.
If the device was switched on or reset, wait about 1 minute until the boot process is complete
before you click Refresh.
Note!
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If using the DTM and PACTware to configure the WirelessHART gateway, the following data is
available only during online parameterization.
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General Data
Displayed
Information

Description

Long Tag

Displays the long tag of the device.
HART 5 devices and older devices do not support long tags. For those
devices, the WirelessHART adapter uses the content of the Message field
which will be displayed here instead.

I/O Card

Indicates the virtual I/O card number to which the device is mapped to. See
chapter 2.1.3

Channel

Indicates the channel of the virtual I/O card that the device is mapped to. See
chapter 2.1.3
The value 0 identifies a WirelessHART device or a WirelessHART adapter,
while the value 1 identifies a wired device connected to a WirelessHART
adapter.

Device Type

Displays the device type as registered at the HCF.

Status

The following communication statuses exist:
communication not possible
communication possible, device not identified
(flashing) communication possible, identification ongoing
device connected and identified

Dev. Status

Note that the device status displayed in the list may differ from the actual
device status because the HART status bits may be interpreted differently.
The following device statuses exist:
maintenance required
out of specification
check function
failure

Measured Values
Displayed
information

Description

Loop Current Analogue value of the primary variable
PV

Value of the primary variable

SV

Value of the secondary variable

TV

Value of the tertiary variable

QV

Value of the quaternary variable
Measured Values

2017-03

Table 5.19
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6

Configuration via Device Type Manager (DTM) and
PACTware
If using the device type manager (DTM) and PACTware to configure the WirelessHART
gateway, the WirelessHART gateway must be connected via Ethernet or RS-485.
Configuration via DTM is identical to the configuration via web interface with the
exception of a few options that are pointed out in the relevant sections. Thus, after you have
added the communication DTM and the device(s) in PACTware, you can follow the instructions
for configuration via web interface.
You can download PACTware, the WirelessHART DTM, the HART IP Communication DTM,
and the HART Communication DTM from www.pepperl-fuchs.com.

Creating a New Project?
Select File > New or click

Create New Project.

A new, unnamed project appears in the main window. The project initially consists of the
entry HOST PC.

Updating the Device Catalog
1. Start PACTware.
2. Select View > Device Catalog.
The Device Catalog window opens.
3. Click Update Device Catalog to update the device catalog.
4. Click Yes to continue.
The updated device catalog appears.

6.1

Ethernet Communication
In order to enable Ethernet communication, you need to add the HART IP Communication DTM
to your project first.

Adding HART IP Communication DTM
1. Select HOST PC in the project view.
2. Choose Device > Add device or click

Add device.

3. Select the entry HART IP Communication.
4. Click OK.
The HART IP Communication DTM is added to the project.

Figure 6.1

HART IP Communication DTM in project view

5. To edit the parameters, right-click HART IP Communication and select Properties.
6. Set the parameters according to your preferences. In most cases, the default values should
be fine.
2017-03

7. Click OK to save the changes and to close the Properties window.
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The IP address, bus address and UDP port of the communication DTM must match the
parameters of the WirelessHART gateway. In some cases, for example, if the WirelessHART
gateway has already been used in another project, you may have to edit these parameters.
When using a new WirelessHART gateway, there is no need to change these parameters,
because the default settings of the WirelessHART gateway already match the default settings
of the Ethernet Communication DTM.

Edit DTM Addresses of the Ethernet Communication DTM
1. Right-click HART IP Communication.
2. Choose Additional Functions > Set DTM addresses.
The Set DTM addresses window is displayed.

Figure 6.2

Set DTM address window

3. Change the parameters as required (see following table).
4. Click Update changed data to apply the new settings.
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5. Disconnect and re-establish the connection between the DTM and the WirelessHART
gateway to activate the new settings.

94

WHA-GW-F2D2-0-A*-Z2-ETH

Configuration via Device Type Manager (DTM) and PACTware

HART IP communication DTM

WirelessHART gateway

Parameter

Explanation

Default

Tag

Gateway name in the
WHA-GW –
Project view of PACTware.
Any name may be entered
(not relevant for connection
to the WirelessHART
gateway)

Bus Address Gateway polling address
1
Must match the settings of
the WirelessHART
gateway.

Parameter

Default
–

Parameterization >
1
Wired Communication >
Protocols > HART > Bus
Address

UDP
Address

Gateway IP address
192.168.0 Parameterization >
192.168.0
Must match the settings of 01.001
Wired Communication > 01.001
the WirelessHART
Interfaces > Ethernet >
gateway.
IP Address

UDP Port

Gateway port number
5094
(HART over UDP)
Must match the settings of
the WirelessHART
gateway.

Parameterization >
5094
Wired Communication >
Protocols > HART > Port
Number

Search for Gateways
The Ethernet communication DTM scans and identifies gateways on the Ethernet segment and
lists the IP addresses of the connected gateways in a table.

6.2

RS-485 Communication
In order to enable RS–485 communication, you need to add the HART Communication DTM to
your project first.

Adding HART Communication DTM
Note!
The HART Communication DTM is not included in the WirelessHART DTM Collection. It can be
downloaded separately from www.pepperl-fuchs.com.
1. Select HOST PC in the project view.
2. Choose Device > Add device or click Add device

.

3. Select the entry HART Communication and click OK.
The HART Communication DTM is added to the project.

Figure 6.3

HART Communication DTM in project view

4. To edit the parameters, right-click the HART communication DTM and select Properties.
5. Set the parameters according to the following table.
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6. Click OK to save the changes and to close the parameter window.
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Parameter

Description

Default

Communica Select HART multiplexer.
tion
interface

HART
modem

Port

Select the COM port of the RS-485 to RS-232 converter or of the COM1
RS-485 to USB converter.

Baudrate

Select the baud rate of the WirelessHART gateway.

19200

RTS Control Depending on the RS-485 to RS-232 converter used, it may be Toggle
necessary to switch the request-to-send control on or off, in order
to switch correctly between reception and transmitting mode.
Master

Specify if you want the WirelessHART gateway to be the primary Primary
or the secondary master. If there is already a primary master,
Master
define the WirelessHART gateway as secondary master.

Preamble

Select the number of preambles for HART communication.

5

Number of Select the number of retries for HART communication in case of 3
communica an error.
tion retries
Start
address

Select the address range in which the HART Communication
DTM searches for HART multiplexers.

End
address

6.3

0
15

Devices
After you have added a communication DTM, add the devices for the WirelessHART gateway.

Adding Devices
1. In the project view, right-click on the entry of the communication DTM.
2. To add a device to the project, choose Add device.
3. Select the entry WHA-GW.
4. Click OK.
The device for the WirelessHART gateway is added to the project.

Figure 6.4

New device below HART IP Communication DTM in project tree

Tip
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After you have added the device for the WirelessHART gateway, you can easily add other
WirelessHART devices by performing a topology scan. To do so, right-click the WirelessHART
gateway and select Connect. When you have an active connection to the WirelessHART
gateway, right-click the WirelessHART gateway and select Topology Scan.
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Topology Scan
The DTM provides a topology scan wizard to detect and store the device structure of the
scanned network in an FDT project. The scan is performed independently on each level for the
communication DTM, the WirelessHART gateway, and the devices.
Note!
Note on Hardware Version
Automatic topology scanning is possible with the WirelessHART gateway, revision 3 or higher.

Topology Scan: Creating the Project Tree Online
You can create the complete project tree for communication DTMs using the topology scan.
The following example shows how to create a project tree for the HART IP Communication
DTM. Ensure that you have added HART IP Communication DTM to the project tree. Ensure
that the HART IP Communication DTM remains active, and proceed as follows:
1. Right-click on the HART IP Communication DTM, and go to Topology Scan.

The topology scan wizard opens.

2017-03

2. Optionally, you can make settings for the HART IP communication DTM: In the Scan Tree,
right-click onto the HART IP Communication DTM. From the context menu that opens,
select DTM Functions > Parameter. In the Settings section on the right, for the HART IP
Communication DTM enter a suitable project tag, determine the communication timeout,
and the number of retries.
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Figure 6.5

Parameter > DTM Functions for HART IP Communication DTM

3. In order to start the topology scan, click on the blue single arrow (1) in the lower left section
of the wizard dialog.

1

2017-03

Scanning is indicated by a status bar. All gateways on the network are listed. All devices
that are connected to the gateways are listed. As scanning takes place, the Scan Tree
section fills with all the detected participants of network, at the same time the project tree is
updated.
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Figure 6.6

Topology scan: Filling up project tree while scanning

4. Close the topology scan wizard.
Your FDT project tree is complete.

Rescanning in Case of Failed Device Detection
In case the topology scan cannot detect any connected devices, ensure that all devices are
switched on. Then you can manually rescan the topology as follows:
1. Manually rescan the WirelessHART adapter. Assign a device type and a semantic ID manually. Confirm by clicking on Apply.

2017-03

Figure 6.7

Topology scan wizard: Issues after completing the scan, in general unkown devices
on the network

2. Close the topology scan wizard.
Your FDT project tree is complete.
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6.4

Online and Offline Parameterization (PACTware)
The concept of online and offline parameterization applies only to configuration via device type
manager (DTM) with PACTware.
■

Offline Parameterization (not connected to device)
If there is no active connection to the device, you can edit and save the data that is stored
locally in PACTware. You can transfer the local data to the device, as soon as a connection
to the device has been established.

■

Online Parameterization (connected to device)
If there is an active connection to the device, you can directly edit the data that is stored
on the device. Parameter changes are immediately stored on the device.

Note!
Data that is edited and stored on the device during online parameterization is not automatically
synchronized with the offline data in the PACTware project. If you change device parameters in
online mode, the data in PACTware differs from the data on the device. To make sure the data in
PACTware matches the data on the device after online parameterization, load the data from the
device into the PACTware project.

Offline Parameterization
1. Right-click the device in the PACTware project view.
2. Choose Parameter > Offline Parameterization.
The window containing the offline data record appears.
3. Modify a parameter by typing in a new value or choosing a new value from the drop-down
list.
4. To accept the new value, press Enter.
5. After all parameter changes have been made, save your project by choosing File > Save.
6. To write the new offline configuration to the device, right-click the device in the project view
and choose Connect.
A connection to the device is established.
7. Right-click the device again and choose Store to device.

2017-03

The new configuration is stored in the device.
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Online Parameterization
Note!
Some options are only available during online parameterization. These options are pointed out
in the relevant sections.
1. Right-click the device in the PACTware project view.
2. Select Connect.
A connection to the device is established.
3. Right-click the device in the PACTware project view.
4. Select Parameter > Online Parameterization.
The window containing the online data opens and the data is read from the device.
5. Modify a parameter by typing in a new value or choosing a new value from the drop-down
list.
6. To accept the new value, press Enter.
The new value is stored in the device immediately.
7. After all parameter changes have been made, you can load the online configuration into the
PACTware project. To do this, right-click on the device entry in the project view and choose
Load from device.
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8. Save your project by choosing File > Save.
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Configuration via DD file and Emerson AMS Suite
You can also configure the WirelessHART gateway by integrating it into a process control
system. The exact procedure how to integrate a device depends on the process control
system. Please refer to the documentation of your process control system manufacturer.
You can download the device description for the WirelessHART gateway from www.pepperlfuchs.com. Install the DD file according to the instructions from the documentation of your
process control system manufacturer.
This manual describes the integration into a process control system using the example of the
Emerson AMS Suite. When integrating the WirelessHART gateway into the Emerson AMS
Suite, the WirelessHART gateway must be connected to your PC via Ethernet.

7.1

Integration
The WirelessHART gateway is integrated into the Emerson AMS Suite by creating a new
wireless network that is established by the WirelessHART gateway.

Create New Wireless Network
1. Make sure the AMS Device Manager is not running.
2. Choose Start > Programs > AMS Device Manager > Network Configuration to start
Network Configuration.
The Network Configuration window appears.

Figure 7.1

Network Configuration window

3. Click Add.
4. Select Wireless Network and click Install.

2017-03

The Add Wireless Network Wizard window appears.
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Figure 7.2

Add Wireless Network Wizard window

5. Click Next.
6. Enter a name for the network in the Network Name field and click Next.

2017-03

7. Enter the IP address of the WirelessHART gateway in the Smart Wireless Gateway Name
or IP Address field and click Add. The default IP address is 192.168.001.001. If you
changed the IP address of the WirelessHART gateway, type in the new IP address.
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Figure 7.3

Connection window

The IP address is displayed in the upper area under Wireless Network Parameters.
8. Click Finish to close the Add Wireless Network Wizard.
The name of the new wireless network is displayed in the Network Configuration
window.

2017-03

9. Click Close to exit Network Configuration.

104

WHA-GW-F2D2-0-A*-Z2-ETH

Configuration via DD file and Emerson AMS Suite

7.2

Configuration
The Device Connection View is a graphical representation of the WirelessHART gateway and
the connected wireless and wired subdevices. From this view you can directly open the
configuration window for each device.

Display Network Participants
1. Start the AMS Device Manager as administrator. To do so, right-click the program icon and
select Run as administrator.

Figure 7.4

Run as administrator

2. Log in to the AMS Device Manager using your user name, password, and the Standard
login type.
3. To establish a connection to your devices, choose View > Device Connection View.
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The Device Connection View window displays the networks from the Network
Configuration window. In this example, Wireless Network 1 represents the
WirelessHART network that is established by the WirelessHART gateway.
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Figure 7.5

Device Connection View window

4. Right-click the network that is created by the WirelessHART gateway and select Rebuild
and Identify Hierarchy.
The WirelessHART gateway is displayed underneath the network. Note that if the device
description has been installed, the WirelessHART gateway is displayed with a devicespecific icon. Otherwise the system uses a generic icon.

Figure 7.6

WirelessHART gateway in Device Connection View

5. To view the wireless and wired subdevices of the WirelessHART gateway, click the + symbol
in front of the device icon.
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The AMS Device Manager checks the HART loops and adds the field devices to the
network tree. Depending on the number of network participants and the network topology,
this process can take up to a few minutes.
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Configure WirelessHART Gateway
Note!
Unless the device description has been installed, you can only configure basic options. The
device description adds device-specific options to the configuration window.
1. To open the configuration window, double-click the WirelessHART gateway in the Device
Connection View.
The configuration window of the selected device appears.

Figure 7.7

Configuration window

2. If you change the value of a field, the background color of this field turns yellow. To apply the
changes, click Send.

Changes are highlighted in yellow

2017-03

Figure 7.8
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The system displays a warning message, asking you to provide an update reason and to
confirm that you want to change the values.

Figure 7.9

Confirm Device Configuration Change window

2017-03

3. To confirm the configuration change, click Yes.
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8.1

MODBUS and HART Status Information on Lost Connection
While you can easily retrieve the status information in the Measurement overview (see chapter
5.7), this chapter describes how to read the MODBUS and HART status information by means
of some examples.

Field Device Loses Connection to WirelessHART Adapter
In this example there are 3 field devices that are connected to the WirelessHART network via a
WirelessHART adapter. Now the field devices have been disconnected from the
WirelessHART adapter.
In the Measurement window the red icon in the Com. Status column indicates that the
connection has been lost.

Figure 8.1

Measurement window

The MODBUS mapping of the device with long tag BARCON looks as follows.
Excerpt from MODBUS Mapping Table
Register

Endregister

Long Tag

IO-Card

Channel

Value

241

242

BARCON

11

1

Loop Current

243

244

BARCON

11

1

PV

245

246

BARCON

11

1

SV

247

248

BARCON

11

1

TV

249

250

BARCON

11

1

QV

251

251

BARCON

11

1

MODBUS
Status

252

252

BARCON

11

1

Device Status

...

...

2017-03

Loop Current and Variables

Figure 8.2

MODBUS readout of register 30241 ... 30250
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The MODBUS readout of registers 30241 ... 30250 results ????? respectively NaN because
no field device is available and therefore no values are available.
Status Information

Figure 8.3

MODBUS readout of register 30251 ... 30252

The MODBUS status information in register 30251 returns 0000000000000101. This
indicates that the cache for command 3 is empty (as there is no device). See chapter 12.2
The HART status information in register 30252 returns 0000000010000000 that corresponds
to the hexadecimal value 0x80. This indicates a device malfunction. See chapter 12.1

WirelessHART Device Loses Connection to Network
In this example there are 4 WirelessHART temperature converters. The device with long tag
40000003410027 lost connection to the WirelessHART network, while the device with long
tag T209innen is still connected.

Figure 8.4

Measurement window

The MODBUS mapping of the device with long tag T209innen looks as follows.
Excerpt from MODBUS Mapping Table for T209innen
Register

Endregister

Long Tag

IO-Card

Channel

Value

11

11

T209innen

1

0

MODBUS
Status

12

12

T209innen

1

0

Device Status

...

...
Status Information for T209innen

Figure 8.5

MODBUS readout of register 30011 ... 30012

The HART status information in register 30012 returns 0000000000010000 that corresponds
to the hexadecimal value 0x10. This indicates that more status information is available via
command 48. See chapter 12.1
This information is also displayed in the Measurement window when hovering over the icon in
the Com. Status column.
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The MODBUS status information in register 30011 returns 0000000000000000. This
indicates that everything is ok. See chapter 12.2
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Figure 8.6

Measurement window

The MODBUS mapping of the device with long tag 40000003410027 looks as follows.
Excerpt from MODBUS Mapping Table for 40000003410027
Register

Endregister

Long Tag

217

218

219

IO-Card

Channel

Value

40000003410 13
027

0

Loop Current

220

40000003410 13
027

0

PV

221

222

40000003410 13
027

0

SV

223

224

40000003410 13
027

0

TV

225

226

40000003410 13
027

0

QV

227

227

40000003410 13
027

0

MODBUS
Status

228

228

40000003410 13
027

0

Device Status

...

...
Loop Current and Variables for 40000003410027

Figure 8.7

MODBUS readout of register 30217 ... 30226

The MODBUS readout of registers 30217 ... 30226 results ????? respectively NaN because
no field device is available and therefore no values are available.
Status Information for 40000003410027

Figure 8.8

MODBUS readout of register 30227 ... 30228
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The MODBUS status information in register 30227 returns 0000000000000101. This
indicates that the cache for command 3 is empty (as there is no device). See chapter 12.2
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The HART status information in register 30228 returns 0000000010110000 that corresponds
to the hexadecimal value 0xB0 with 0xB0 = 0x80 + 0x20 + 0x10. See chapter 12.1
■

0x80: device malfunction

■

0x20: cold start

■

0x10: more status available

This information is also displayed in the Measurement window when hovering over the icon in
the Com. Status column.

Figure 8.9

8.2

Measurement window

Network Enhancement
After having installed and set up a wireless network, give the network a couple of hours to
stabilize itself before taking the following steps.
Once the WirelessHART network is running, there are some simple measures that will help
enhancing network performance and reliability. Those measures are described in the following.

Verify Connections
Check that each device has joined the network and is communicating properly. See chapter
5.4.2 Details
If you cannot establish a connection to a device, the device is probably too far away or an
obstacle blocks the radio waves. In this case, add an additional device to bridge the gap.

Eliminate Bottlenecks
If the messages of several devices all have to pass through one single device to get to the
WirelessHART gateway, the network has a bottleneck. If the device at the bottleneck fails,
whole parts of the network get cut off from communication because there are no alternative
paths to route messages.

2017-03

To eliminate bottlenecks in a wireless network, add at least one device near the bottleneck to
provide redundant communication paths.
There should always be at least two communication paths from one device to another.
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Figure 8.10

Eliminating a bottleneck

1. Bottleneck
2. WirelessHART gateway
3. Possible position of an additional WirelessHART device eliminating the bottleneck

Expand the Network
In an industrial environment, there are several potential obstacles for radio waves, for example
buildings, walls, pipes, or even moving obstacles like trucks. Those obstacles can reflect, bend,
diffuse or block radio waves. The effects of reflection, bending and diffusion create new waves
which interact with the original ones and with each other. They can amplify or nullify each other.
Due to the interference of reflections, moving the antenna a few centimeters can help. If there
are obstacles blocking data transfers between wireless devices, add additional devices to
provide alternative communication paths. The more devices exist in a WirelessHART network,
the more reliable it gets.

Optimize Coexistence with other Wireless Networks
WirelessHART networks use the frequency spectrum between 2400 ... 2483.5 MHz according
to IEEE 802.15.4. Various other wireless technologies also use this frequency spectrum, for
example WLAN (IEEE 802.11) and Bluetooth (IEEE 802.15.1). Measures must be taken to
ensure that the various wireless technologies do not affect each other.
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If there are problems with other wireless technologies disrupting the WirelessHART network,
create a channel blacklist that makes the WirelessHART gateway skip certain channels known
to provide persistent interference. See chapter 5.2.1
If possible, you can also manage the frequencies used by other networks and block the usage
of channels already used by the WirelessHART network (frequency management).
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Maintenance and Repair

9.1

WHA-GW*
Danger!
Danger to life from using damaged or repaired devices.
Using a defective or repaired device can compromise its function and its electrical safety.
■

Do not use a damaged or polluted device.

■

The device must not be repaired, changed or manipulated.

■

If there is a defect, always replace the device with an original device from Pepperl+Fuchs.

Danger!
Explosion hazard or loss of radio approval through unsuitable accessories
The use of unsuitable or unapproved accessories may void the Ex certification or radio
approval of the device and present an explosion hazard or violate the national radio
regulations.
Only use suitable, certified remote antennas and accessories that are listed in the installation
examples or that respect the limits mentioned below. If in doubt, consult your national
regulations expert.
Danger!
Danger to life from electric shock through degree of protection violation
Failing to ensure the degree of protection for the enclosure according to EN 60529 can result in
severe or lethal electric shock.
Ensure that the enclosure meets the required degree of protection during mounting and
installation activities: 
- All seals must be undamaged and correctly fitted
- All screws of the housing/housing cover must be tightened with the appropriate torque
- Only cables of the appropriate size must be used in the cable glands
- All cable glands must be tightened with the appropriate torque
- All unused cable glands must be sealed or plugged with corresponding stopping plugs
Danger!
Explosion hazard from premature powering
Powering parts of the system during installation or maintenance leads to added currents. This
very likely results in a current flashover generating sparks. The sparks can ignite the
surrounding potentially explosive atmosphere.
Prior to installation and maintenance activities, ensure that the device is disconnected from the
power supply. Activate the power supply only after all the circuits required for operation have
been fully assembled and connected
The national requirements apply to maintenance, servicing, and inspection of associated
apparatus.
No maintenance is necessary if the devices are operated properly, observing the mounting
instructions and ambient conditions.
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The devices must not be repaired, changed or manipulated. If there is a defect, the product
must always be replaced with an original device.
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Troubleshooting

10.1

Faults Indicated by LEDs of the WirelessHART Gateway
Indication

Possible cause

Corrective action

Red LED is on

Hardware fault that makes normal
operation of the WirelessHART
gateway impossible.

Try powering the WirelessHART
gateway down and up again. If the
problem persists, please return the
WirelessHART gateway to
Pepperl+Fuchs for repair.

Red LED flashes Under certain conditions the LED
flashes while the WirelessHART
gateway tries to eliminate the fault.

10.2

If the problem persists, please
contact Pepperl+Fuchs customer
service.

Wired Communication Faults
Fault

Possible cause

Corrective action

The host is not
able to establish
an Ethernet
connection to the
WirelessHART
gateway.

The WirelessHART
gateway is connected to
the Ethernet with a straight
through connection
although a crossover
connection is necessary
(or vice versa).

Access the Ethernet interface of the
WirelessHART gateway.
Interchange the green wire with the orange
one, and the white/orange wire with the
white/green one.
This action changes a crossover connection
into a straight-through connection and vice
versa.

The Ethernet parameters
of the WirelessHART
gateway are incorrect.

Check the Ethernet parameters of the
WirelessHART gateway. See chapter 5.3.2

The Local Area Connection Configure the Local Area Connection
Properties of your PC are according to the instructions given. See
not configured correctly.
chapter 4.1

The host is not
able to establish
a serial
connection to the
WirelessHART
gateway.

If you are parameterizing
via the web interface:
Maybe your web browser
uses proxies.

Deactivate proxies in your browser.

Wrong parameters (e.g.
COM port, address range)
are set in the
communication DTM.

Check the parameters in the communication
DTM. See chapter 6.2
Also check the baud rate/polling address
configured via the DIP switches inside the
enclosure. See chapter 2.3.2
If the RS-485 bus ends at the WirelessHART
gateway, activate the terminator by setting DIP
switch number 7 to ON (see chapter 2.3.2) or
by using the serial interface (see chapter
5.3.1).

2017-03

The host is not
The terminator is not
able to establish activated.
a serial
connection to the
WirelessHART
gateway, or the
signal quality is
poor.
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10.3

Wireless Communication Faults
Fault

Possible cause

Corrective action

The
WirelessHART
gateway cannot
find a
WirelessHART
device in the
network.

The device has not yet
joined the network.

The joining process may take a while. Check
the join status in the instrument list of the
WirelessHART gateway. Alternatively, check
the wireless communication parameters (join
status) of the device via a HART modem
connected to the device.

The device carries the
wrong network ID and/or
the wrong join key.

Check the wireless communication
parameters of the device via a HART modem
connected to the device. The device and the
WirelessHART gateway must have the same
network ID and join key.

There are not enough
Check the number of neighbors (Diagnosis >
neighboring
Wireless Communication). There should be at
WirelessHART devices
least 2 neighbors.
within the device's antenna
range.
There are not enough
Check the number of neighbors (Diagnosis >
neighboring
Wireless Communication). There should be at
WirelessHART devices
least 2 neighbors.
within the device's antenna
range.
Walls or other
Check the position of the WirelessHART
static/moving objects block gateway or use an external antenna. See
the radio signals, or the
chapter 3.1
antenna is not aligned
vertically.

2017-03

The wireless
connection to a
WirelessHART
device is poor
and disappears
from time to time
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Telecommunication Compliance
■

ETSI (R&TTE)

■

FCC Part 15.247 for wireless applications in the area of 2.4 GHz

■

EN 300 328

The usage of 2400 MHz equipment is bound to local restrictions. Ensure that local restrictions
allow usage of this device before commissioning.
Guideline

Bulgaria

General authorization required for outdoor use
and public service.

Italy

If used outside of own premises, general
authorization is required.

Japan

The device is granted pursuant to the
Japanese Radio Law and the Japanese
Telecommunications Business Law.
The device must not be modified (otherwise
the granted designation number will become
invalid).

Latvia

The outdoor usage of the 2.4 GHz band
requires an authorization from the Electronic
Communications Office.

Norway

May be restricted in the geographical area
within a radius of 20 km from the center of NyAlesund.

Rumania

Use on a secondary basis. Individual license
required.

2017-03

Country
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Appendix

12.1

HART Status Information
HART Device Status
The HART device status or field device status indicates the current operating status of the field
device.
Code

Parameter

Description

0x01

Primary Variable The PV is beyond its operating limits.
Out Of Limits

0x02

Non-Primary
Variable Out Of
Limits

A device variable not mapped on the PV is beyond its operating
limits.

0x04

Loop Current
Saturated

The loop current has reached its upper (or lower) endpoint limit
and cannot increase (or decrease) any further.

0x08

Loop Current
Fixed

The loop current is being held at a fixed value and is not
responding to process variations.

0x10

More Status
Available

More status information is available via command 48.

0x20

Cold Start

A power failure or device reset has occurred.

0x40

Configuration
Changed

An operation was performed that changed the configuration of
the device.

0x80

Device
Malfunction

The device detected a serious error or failure that compromises
device operation.

HART Extended Device Status
Code

Parameter

Description

0x01

Maintenance
Required

This bit is set to indicate that, while the device has not
malfunctioned, the field device requires maintenance.

0x02

Device Variable
Alert

This bit is set if any device variable is in an alarm or warning state.
The host should identify the device variable(s) causing this to be
set using the device variable status indicators.

0x04

Critical Power
Failure

For battery powered devices. This bit is set when the power is
becoming critically low. Devices must be able to sustain their
network connection for at least 15 minutes from when this bit is
set.

0x08

Failure

When this bit is set, one or more device variables (for example,
measurement or control values) are invalid due to a malfunction
of the field device or its peripherals.

0x10

Out Of
Specification

When set, this bit indicates deviations from the permissible
ambient or process conditions have been detected that may
compromise measurement or control accuracy (for example,
device performance may be degraded given current operating
conditions).

0x20

Function Check

This bit is set if one or more device variables are temporarily
invalid (for example, frozen) due to ongoing work on the device.

Command 48

2017-03

Command 48 returns additional status information that is not included in the HART device
status response code.
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All field devices must support at least bytes 0 ... 8. Thus, the minimum response length of
command 48 is 9 bytes. If a field device supports more than one analog channel, bytes 9 ... 13
must be supported as well. In this case, the minimum response length of command 48 is 14
bytes.
Response Data Bytes
Byte

Parameter

0

Device-Specific ■ 0x01 Manager Fault
Status 0
Extended Device ■ 0x02 Non-Volatile Memory Defect
Malfunction
■ 0x04 Volatile Memory Defect

1

2

3

Device-Specific
Status 1
Gateway
Operation in
Progress

Device-Specific
Status 2
Extended Lists
Changes
Device-Specific
Status 3
Cumulative
Device Status

Description

■

0x08 Ethernet Communication Fault

■

0x10 Wired Device Duplicated

■

0x20 Long Tag Duplicated

■

0x40 Electronic Defect

■

0x80 RS-485 Communication Fault

■

0x02 Block Transfer (not supported)

■

0x04 Delayed Answer

■

0x08 Self-Test (not supported)

■

0x20 Device List Update

■

0x40 Network Manager Reset In Progress

■

0x80 Start-Up Phase

■

0x01 Instrument List Changed

■

0x04 Active Device List Changed

■

0x01 Primary Variable Out Of Limits

■

0x02 Non-Primary Variable Out Of Limits

■

0x04 Loop Current Saturated

■

0x08 Loop Current Fixed

■

0x10 More Status Available

■

0x20 Cold Start

■

0x40 Configuration Changed

■

0x80 Device Malfunction

Device-Specific ■ 0x01 Maintenance Required
Status 4
Device Operation ■ 0x02 Device Variable Alert
in Progress
■ 0x04 Critical Power Failure

5

Device-Specific ■ 0x02 "Configuration Changed Bit Reset" Procedure
Status 5
Device Operation ■ 0x04 "Sub-Device Update" Procedure
in Progress
■ 0x08 "Device Update" Procedure

6

Extended Device Not available
Status

7

Device Operating Not available
Mode

2017-03
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Byte

Parameter

8

Standardized
Status 0
Standardized
Device
Malfunction

Description
■

■

0x02 Non-Volatile Memory Defect
The non-volatile memory check is invalid or corrupt, or the
battery of a battery-powered memory is defective.

■

0x04 Volatile Memory Defect
The RAM memory check is invalid or corrupt.

■

0x08 Watchdog Reset Executed
A watchdog reset has been executed.

■

0x10 Environmental Conditions Out Of Range
An internal or environmental condition is beyond acceptable
limits.

■

0x20 Power Supply Conditions Out Of Range
The power supply is outside its allowable range.

■

0x40 Electronic Defect
A hardware problem has been detected.

9

Standardized
Status 1

Not available

10

Analog Channel
Saturated

Not available

11

Standardized
Status 2
Standardized
Lists Changes

■

■

12.2

0x01 Simulation Active
The device is in simulation mode and one or more of its
device variables are not representative of the process.

0x01 Instrument List Changed
When set, the gateway has lost communication with one of its
sub-devices or discovered a new sub-device. This bit is reset
if command 74 is issued. The current sub-device list is read
using command 84.
0x02 Duplicate Master Detected
The adapter has discovered another master with the same
address connected to its token-passing interface.

12

Standardized
Status 3

Not available

13

Analog Channel
Fixed

Not available

14 ... 24 Device-Specific
Status
Information

Not available

MODBUS Status Information
MODBUS-Specific Status
Code

Parameter

Description

0x01
(LSB)

Cache Validity

Set to 1 when the cache of the device for HART command 3 is
empty.

0x02
(LSB)

Identification
Ongoing

Set to 1 when the gateway is performing a device identification
procedure.

2017-03

LSB: lower significant byte
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12.3

CSV File Structure
Use a semicolon ; as separator for the values in the CSV file. If a value already contains a
semicolon you must put the value into quote signs ". If the value already contains quote signs,
put the entire value into quote signs " and replace the original quote signs with two quote signs
"".
Example!
The value this is a "long tag" that contains quote signs must be entered like this:
"this is a ""long tag"" that contains quote signs"
Avoid special characters. They can easily be corrupted or they can cause the whole data row to
be skipped during the import of the CSV file.
Avoid leading blanks, trailing blanks, and tabs, especially for integer or hexadecimal values.
Respect the data type of each column.
If a mandatory column is missing, the whole file is rejected and nothing is imported.
If a mandatory value is missing, the corresponding data row is skipped.

MODBUS Mapping
The files for the MODBUS mapping contain the following columns.

mandatory int decimal

Mapping Code

Information Code
mandatory int decimal

Register Type
mandatory int decimal

mandatory int decimal

Register

Long Tag

Channel
mandatory string[32]

int decimal

int decimal

IO-Card

Device Id
6 digits hex

4 digits hex

Expanded Device
Type Code

File Structure

The data in the RegisterType, InformationCode, and MappingCode columns is encoded as
described in the tables below.
RegisterType Codes
Value

Description

1

Discrete Input

3

Input Register

2017-03

InformationCode Codes
Value

Description

0

HART Status (RegisterType Code = 3)

1

CMD 48 Status (RegisterType Code = 3)

2

Device Variables (RegisterType Code = 3)

3

MODBUS Status (RegisterType Code = 3)

4

Discrete Variables (RegisterType Code = 3)

121

WHA-GW-F2D2-0-A*-Z2-ETH
Appendix

Note that the MappingCode codes depend on the InformationCode code.
MappingCode Codes
Information Code

Value

Description

0 (HART Status)

0

Device Status

1

Extended Device Status

2

Device Status & Extended
Device Status

1 (CMD 48 Status)

0 ... 12

CMD 48 status word to be
mapped
0 maps CMD 48 bytes 0&1
1 maps CMD 48 bytes 2&3
and so on
Note: 12 maps CMD 48 byte
24 only

2 (Device Variable)

0 ... 242

Device Variables
For more information on what
device-specific information is
available and on the devicespecific unit codes, see the
manual of the sub-device.

243

Battery Life

244

Percent Range

245

Loop Current

246

Primary Variable

247

Secondary Variable

248

Tertiary Variable

249

Quaternary Variable

255

Slot 0 data time stamp

3 (MODBUS Status)

0

"Mod Stat" information

4 (Discrete Variable - LSB)

0 ... 255

Discrete Variable Index
The less significant byte of the
variable is mapped.

5 (Discrete Variable - MSB)

0 ... 255

Discrete Variable Index
The most significant byte of
the variable is mapped.

6 (Network Statistic)

0

Reliability

1

Stability

2

Latency

3

Lost Upstream Packets

LSB: least significant byte
MSB: most significant byte

Instrument List
The files for the instrument list contain the following columns.
Expanded Device
Type Code
Device Id

IO-Card

Channel

Long Tag

4 digits hex

int decimal

int decimal

string[32]

6 digits hex

mandatory
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Topology View
The files for the topology view contain the following columns.
Note that the X- and Y-origins of the background image are not part of the CSV file, as these
coordinates are related to the background image.

Z-Coordinate
float decimal

mandatory float decimal

Y-Coordinate

X-Coordinate
mandatory float decimal

Range

Units Code
float decimal

mandatory string[32]

int decimal

Long Tag

Channel
int decimal

int decimal

IO-Card

Device Id
6 digits hex

4 digits hex

Expanded Device 
Type Code

File Structure

Diagnostic Details
The files you can export under Diagnostics > Wireless Communication > Details contain
the following columns. There are no mandatory columns as there is no import function.
Nevertheless, you can export the data in CSV format for documentation.

12.4

Stability
float

int decimal

RSSI

Neighbors
string[32]

Latency
float

float

Reliability

Recent Join Date
yyyy:mm:dd hh:mm:ss

Number Of Joins
int decimal

Device Status
2 digits hex

2 digits hex

Status

Long Tag
string[32]

Channel
int decimal

int decimal

IO-Card

Device Id
6 digits hex

4 digits hex

Expanded Device
Type Code

File Structure

Supported Commands
The following tables show the HART commands supported by the device.
Note!

2017-03

Unlike a HART multiplexer the WirelessHART gateway only accepts commands directly
addressed to its HART slave address.
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12.4.1

Universal Commands
Command

Action

Description

Identity Commands
0

Read unique identifier

12 Bytes device identifier are given in
the response

11

Read unique identifier using tag

12 Bytes device identifier are given in
the response, if the given tag complies
to the tag of the gateway

21

Read unique identifier using long tag

12 Bytes device identifier are given in
the response, if the given long tag
complies to the long tag of the
gateway

Static Parameter Commands
13

Read tag, descriptor, date

Read the 8 digit tag, the 16 digit
description and the date.

18

Write tag, descriptor, date

Write the 8 digit tag, the 16 digit
description and the date

12

Read message

Read the 32 digit message

17

Write message

Write the 32 digit message

20

Read long tag

Read the 32 digit long tag

22

Write long tag

Write the 32 digit long tag

16

Read final assembly number

19

Write final assembly number

Status Commands

12.4.2

38

Reset configuration changed flag

48

Read additional status

Reset the "Configuration changed"
response code

Common Practice Commands
Command

Action

Description

Device Management Commands
41

Perform device self test

Initiates the self test function in the
device

42

Perform device reset

Immediately after the response the
microprocessor of the device will be
reset.

89

Set real-time clock

12 Bytes device identifier are given in
the response, if the given long tag
complies to the long tag of the
gateway.

90

Read real-time clock

512

Read country code

513

Write country code

124

59

Write number of response preambles The number of preambles insert in
response telegrams can vary from 2 to
20. Default setting is 4.

106

Flush delayed response buffers

Flush all gateway DR buffers.
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Command

Action

Description

I/O System Commands
74

Read I/O system capabilities

Also returns number of detected
devices.

77

Send command to sub-device using
card/channel

Request embeds full Hart command.

85

Read I/O channel statistics using
card/channel

Read channel communication
statistics.

86

Read sub-device statistics using list
index

Read device communication statistics.

84

Read sub-device identity summary
using list index

Allows to read the Instrument list (a
single item at a time).

I/O System (HOST I/F) Commands

12.4.3

88

Write I/O system retry count

94

Read I/O system host statistics

Read host I/F communication
statistics.

Wireless Commands
Command

Action

Description

Network information commands
768

Write join key

Write the network's unique join key.
Only possible in (see chapter 5.2.1).

773

Write network ID

Write the unique network ID.

774

Read network ID

Read the unique network ID.

775

Write network tag

Write the network tag. The network tag
identifies the device in the
WirelessHART network.

776

Read network tag

Read the network tag.

794

Read UTC time mapping

Read the time setting for the network.

797

Write Radio Power

798

Read Radio Power

840

Read Network Device's Statistics

Active / White / Black lists commands

2017-03
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814

Read Device List entries using list
index

816

Delete device List table entry using
unique ID

821

Write network access mode

822

Read network access mode

Device Commands
Command

Action

Description

835

Read network device burst mode list
using unique ID

Read the device burst message list.

836

Flush device cached responses using Instructs the gateway to flush all
unique ID
cached responses for the relevant
device.
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12.5

Software License
Open Source Software Information
The product you have bought uses open source software. According to the open source
license terms and conditions for the use of the open source software we provide you with the
following information:
1. Under the program source code you will find a list of the different open source software embedded in the product. The program source code is available under www.pepperlfuchs.com.
2. In the list the copyright owners of the respective open source software are named.
3. Under the program source code the license terms and conditions for the use of the different open source software are available.
4. The sublicense for the use of the open source software embedded in the product is granted to you under the same license terms and conditions as required by the copyright owners (see Nr. 3 above).

2017-03

5. We expressly point out that the license terms and conditions contain extensive limitations
of liability.
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